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Thank you for purchasing this Panasonic product.

■ Before using this software, please read the instructions carefully.

DPQP1544ZB/X1(E)



2

Precautions and Disclaimers ................................................................................................ 4

What You Can Do with “Geometry Manager Pro for FMP series” ..................................... 5

Check Your Computer ............................................................................................................ 7
System requirements ........................................................................................................................................................ 7

Necessary Environment for Computers to be Connected ............................................................................................7

Installing/Uninstalling Software ............................................................................................ 8
Installation ..........................................................................................................................................................................8

Installing “Geometric & Setup Management Software” (Geometry Manager Pro for FMP series) ................................ 8

Software Uninstall .............................................................................................................................................................. 9

Preparation ........................................................................................................................... 10

Starting and Exiting the Application .................................................................................. 12
Starting the application ................................................................................................................................................... 12

Exiting the application .................................................................................................................................................... 15

Adjustment and Settings ..................................................................................................... 16
Main screen ....................................................................................................................................................................... 16

Adjustment area ............................................................................................................................................................ 17
Main menu ..................................................................................................................................................................... 18
Icon menu ......................................................................................................................................................................23
Common operation area ...............................................................................................................................................24
[AUTO ADJUST] (Auto Screen Adjustment) button ...................................................................................................... 31
Status bar ...................................................................................................................................................................... 31

Geometry Correction .......................................................................................................................................................32
Geometry screen ...........................................................................................................................................................32
Selecting the control points ...........................................................................................................................................36
Free Grid (Free-form correction) ................................................................................................................................... 37
4 Corner (4-corner correction) ......................................................................................................................................38
Keystone (keystone shape correction) ..........................................................................................................................39
Cylindrical screen (cylindrical shape correction) ..........................................................................................................40
Elliptical screen (elliptical shape correction) ................................................................................................................. 41
Spherical screen (spherical correction) ........................................................................................................................43
Rotation (rotation correction) .........................................................................................................................................44

Content Splitting ..............................................................................................................................................................45
Contents screen ............................................................................................................................................................46

Edge Blending ..................................................................................................................................................................52
Edge Blending screen ...................................................................................................................................................52
User-defined curve setting screen ................................................................................................................................60

Black Level Adjustment................................................................................................................................................... 61
Black Level screen ........................................................................................................................................................ 61

Color Matching .................................................................................................................................................................67
Color Matching screen .................................................................................................................................................. 67

Masking .............................................................................................................................................................................68
Masking screen .............................................................................................................................................................69
Line Masking ................................................................................................................................................................. 71
Custom Masking ............................................................................................................................................................72

Contents



3

Contents

Auto Screen Adjustment ..................................................................................................... 76
Preparing Auto Screen Adjustment ............................................................................................................................... 76

Compatible screens for Auto Screen Adjustment .......................................................................................................77

Operation flow for Auto Screen Adjustment ................................................................................................................ 78

Auto Screen Adjustment procedure ..............................................................................................................................79
Starting Auto Screen Adjustment and selecting the adjustment item ........................................................................... 79
Camera Select (Camera selection) ............................................................................................................................... 81
Projector Select .............................................................................................................................................................82
Camera Setting .............................................................................................................................................................84
Projection Setting ..........................................................................................................................................................85

Live View ............................................................................................................................... 99
Live View Preparation ......................................................................................................................................................99

Live View Procedure ........................................................................................................................................................99
Camera Search screen .................................................................................................................................................99
Camera List screen .....................................................................................................................................................100
Live View screen ......................................................................................................................................................... 101

Operation by Gamepad ...................................................................................................... 104

Frequently Asked Questions ............................................................................................. 105

Trademarks ......................................................................................................................... 107



4

Precautions and Disclaimers
 z Precautions regarding security

When using the “Geometric & Setup Management Software” (Geometry Manager Pro for FMP series), security breaches of 
the type described below are conceivable.

 z Leakage of your private information via this software
 z Illegal operation of this software by a malicious third-party
 z Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
 z Make sure the password is as hard to guess as possible.
 z Change the password periodically.
 z Panasonic Projector & Display Corporation and its affiliated companies never directly ask customers for their password. 
Do not give out your password even if directly asked by a third-party representing themselves as Panasonic Projector & 
Display Corporation.

 z Run Windows Update regularly to keep your computer up to date.
 z Always use on a network that has safety protection such as a firewall implemented.
 z Set the password for the computer you are using in order to set limits on user accessibility.

 z This software makes use of the following software. 
A portion of this software is based in part on the work of the Independent JPEG Group.

 z The illustrations and display examples used in this manual may differ from the actual product.

 z A part that is described as “device” in this manual and the software refers to an FMP series media processor manufactured 
by Panasonic Projector & Display Corporation.

 z Panasonic Projector & Display Corporation cannot be held liable for damages arising from data corruption or loss as a 
result of using a device and projectors. Please note that you are strongly recommended to save the setting information 
saved to the device and projectors also on your computer. Saving on a computer can be performed from the File submenu 
of this software. (  page 18)
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What You Can Do with “Geometry Manager Pro for FMP series”
Geometry Manager Pro for FMP series (hereinafter, “this software”) is software to use an FMP series media processor 
manufactured by Panasonic Projector & Display Corporation to perform real-time geometric correction and other fine 
adjustments and corrections for the images projected from projectors.
Advanced screen adjustments such as the following can be made with this software.

 � Geometry correction
When projecting images onto a screen surface that is not perfectly flat (such as the 
wall of a building) or projecting them onto a screen surface at an angle, the images 
become distorted.
When projecting images in these kinds of special environments, the geometry 
correction function serves to correct the images to counter the shape of the screen 
surface.

 � Content splitting
This function makes it possible to construct a screen by arranging a multiple number 
of projectors in a free layout, and then arrange the content images to be projected 
onto it while viewing the actual projected images.

 � Edge blending
This function serves to correct the brightness and makes the joins between the 
images less visible when the images projected from a multiple number of projectors 
are combined to form a single image.
This function can support a wide variety of shapes for the image joins between 
projectors that are created by the free layout of projectors.

 � Black Level Adjustment
This function allows making the appearance of black uniform by adjusting the 
brightness and coloring of the black parts in the projected image of each projector 
when images projected from a multiple number of projectors are combined to form a 
single image.

 � Masking
This function makes it possible to mask certain parts of the projected images, 
projecting only the required parts.
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What You Can Do with “Geometry Manager Pro for FMP series”  

 � Auto Screen Adjustment (AUTO ADJUST)
This allows simple automatic adjustment of geometry correction, edge blending, and black level according to the shape of 
the screen through use of a camera.

Note
To use the Auto Screen Adjustment function, prepare a camera separately.  “Camera connection” (page 76)

 � Other functions
Color matching adjustment can be performed for the projectors connected to the device.
In addition, the following functions can be performed by directly connecting with the projectors. For details, refer to the 
operating instructions for “Geometry Manager Pro Ver.6.7.”

 z Lens adjustments and input signal adjustments
 z Some of the projector’s menu operations can be carried out on a computer screen.



7

Check Your Computer

System requirements
The computer must meet the following requirements in order to use the supplied software.

OS: Microsoft Windows 11 (Windows 11 Home/Pro 64bit)
 Windows 10 (Windows 10 Home/Pro 64bit)
 Compatible with English, Japanese or Chinese language versions of the above operating systems.
  • For a 64bit OS, this application runs on WOW64.
CPU: At least minimum required by OS
Memory: At least minimum required by OS
Available disk space:
 16 GB or greater (Further available space is necessary to save projector information)
Other requirements:
  A display with a resolution of 1 600 × 900 pixel or higher using High Color (16 bit) or higher 
  LAN port for a wired LAN (10Base-T/100Base-TX / 1000Base-T) 
    USB 2.0-compatible port or higher (when using the Auto Screen Adjustment function with a camera)

Note
 z Please understand that operation is not guaranteed if this software application is used in a system environment other than 
that specified above or on a home-built computer.

Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.

Necessary Environment for Computers to be Connected
Be sure to check the following settings when connecting projectors to the computer via a wired LAN connection.

Computer with a built-in LAN function
 z Is your LAN switched on?

Computer without a built-in LAN function
 z Is your LAN adapter properly recognized? 
Please install the LAN adapter driver beforehand. 
For details on how to install the driver, please refer to instructions accompanying the LAN adapter.

 z Is your LAN adapter switched on?

Note
 z It may not be possible to establish a connection with the projector if security (firewall) software or utility software for LAN 
adapter are installed.  

 “Frequently Asked Questions” (page 105)
 z Operation is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.
 z An Internet connection is required to perform activation.
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Installing/Uninstalling Software

Installation
Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.

Installing “Geometric & Setup Management Software” (Geometry Manager Pro for FMP 
series)

1 Download the software.

 z Download “Geometry Manager Pro for FMP series”.  
Log in to PASS*1 on the following website, click [Software Download], and follow the on-screen instructions to 
download the software. 
https://docs.connect.panasonic.com/projector/pass 
You must be registered with PASS to log in to it. 
*1   PASS: Panasonic Professional Display and Projector Technical Support Website. 

2 The installer starts up.

Double-click the downloaded “Installer.exe” file.

Follow the on-screen instructions to install the application.

Note
Perform this procedure using an account with administrator privileges.

3 As soon as the installation process is completed, a shortcut icon is created on the desktop.

Note
 z When installing “Geometric & Setup Management Software (Geometry Manager Pro for FMP series),” also install 
“Auto Screen Adjustment plug-in software” at the same time.

 z If an identical version of the software is already installed, the following screen for selecting whether to repair or 
remove the existing version appears.



9

Installing/Uninstalling Software Software Uninstall

 � To repair defects in the software, select “Repair Geometry Manager Pro for FMP series”, and click [Finish].  
To uninstall the existing version before installing the software again, select [Remove Geometry Manager Pro for 
FMP series], and click [Finish].

Software Uninstall
Enter and then select “Apps & features” in the search box of the task bar, select [Geometry Manager Pro for FMP series 
Ver.* .* ]*1, and click [Uninstall].
*1 The “*” represent the version number.

Note
Perform this procedure using an account with administrator privileges.
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Preparation
 � Device and computer connections

Use a LAN cable to connect the device with projectors connected and the computer.
Up to 99 projectors can be connected to the device.

Note
 z When connecting with a projector to make adjustments without using a device, refer to the operating instructions for 
“Geometry Manager Pro Ver.6.7.”

 z Set the [Picture Gamma] setting on the projectors to 2.2 before use. When connecting to non-Panasonic projectors, set the 
setting corresponding to [Picture Gamma] to 2.2 before use.

 z When using a hub to connect, whether or not a straight cable or crossing cable or both can be used depends on the system 
configuration. Please consult your network administrator for details.

 � Setting the Computer
Network Setup

 z Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment. 
(Please consult your network administrator for details.)

 z If “use of automatic script” is checked for your web browser, please uncheck.
 z If “Use of Proxy server in LAN” is checked for your web browser, please uncheck, or set the projector IP address to 
“Exceptions” in the detailed proxy settings.

 � Setting the Device
Network Setup

Set the IP address, subnet mask, and default gateway according to your operating environment. (Please consult your 
network administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on 
the LAN.
If the entered IP address is used by another device, the device cannot be registered.

 z For models that can be set, enable both WEB Control and Command Control.
 z For models in which the Web port number can be set, set the port number to “80”.

Note
 z Refer to operating manual of the device for method on configuring the device.
 z If prompted to set a user name and password for the account in the WEB control screen of the device, complete those 
settings.

 z This software identifies the device using the configured IP address. If DHCP is set to ON in the device network setting in a 
network environment that uses a DHCP server etc., the DHCP server may change the IP address allocated to the device, 
making it impossible to connect using this software.  
Please ensure the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP 
address allocated to the device. (Please consult your network administrator for details.)

 � Activation
For adjustments made when projecting with projectors connected to the device, you do not need to apply an upgrade kit  
(ET-UK20 or ET-CUK10) to the projectors and an upgrade kit (ET-CUK10P) to the computer.
When connecting with a projector to make screen adjustments without using a device, such as with Auto Screen Adjustment, 
there are functions that are enabled and functions that are expanded by performing activation. For details, refer to the 
operating instructions for “Geometry Manager Pro Ver.6.7.”
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Preparation

 � Camera connection
To use the Auto Screen Adjustment function, prepare a camera separately.
For details on supported cameras and lenses and how to connect the camera to the computer, refer to “Auto Screen 
Adjustment” (page 76).
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Starting and Exiting the Application

Starting the application
Double-click the shortcut icon on the desktop.
When the application starts, the connection settings screen appears.

LAN connection

File connection

Select [  ] or [  ] to use a LAN connection for the device and computer, and select 

[  ] to connect by loading a saved file.

The following items can be selected from the [Option] menu at the top left of the connection settings screen.
Activation (ET-CUK10P)
Activation (ET-UK20/ET-CUK10)

 �These are items that are used when connecting with a projector to make adjustments without using a device. For 
details, refer to the operating instructions for “Geometry Manager Pro Ver.6.7.”

Display Theme
This switches the theme (color scheme) of this software. 
You can select from [Dark Gray] and [Light Gray].

Command Control
Control command data set in the Command Control screen (registered commands and registered scripts) can be 
saved to a file or read from a file.

 �This is a function that is used when connecting with a projector to make adjustments without using a device. For 
details, refer to the operating instructions for “Geometry Manager Pro Ver.6.7.”

Service Password
This menu is used to support maintenance. It is not normally used.

Version
This is where the application’s version information can be checked.
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Starting and Exiting the Application Starting the application

 � LAN connection
Select the search method for the device to be connected, and configure the following settings.

IP address to use when searching for a projector
Up to four projectors can be connected to the device, and an IP address is specified for each of the projectors on the WEB 
control screen of the device. When searching for a projector in this software, you need to specify the IP address that was 
set on the WEB control screen of the device. Please note that some of settings made in this software may not be applied 
correctly if the IP address set on the WEB control screen of the projector is specified.
The IP address to specify is as follows in accordance with the settings of [Correction Settings] and [Screen Settings] in 
[Player] → [Settings] on the WEB control screen of the device. For details, refer to the operating instructions for ET-FMP50/
ET-FMP20.

 z When [Output Mode] of [Correction Settings] is “1”:
IP address set in [Screen 1 IP Address] of [Screen Settings].

 z When [Output Mode] of [Correction Settings] is “4”:
IP addresses set in [Screen 1 IP Address], [Screen 2 IP Address], [Screen 3 IP Address], and [Screen 4 IP Address] of 
[Screen Settings].

IP Address
Select this to search by specifying the IP address of the projector to be connected.

Start IP Address:
Input the IP address of the projector to be connected to the computer. When searching for a connected projector, 
enter an IP address to start searching.
End IP Address:
When searching for a connected projector, select the check box and enter an IP address to end searching.

Network
Select this to search for a projector within the same network as your computer. The IP address and subnet mask of your 
computer are displayed in the list.

Port
Set here the number of the port that is to be connected to the projector. When connecting with a device, set the port 
number set on that device.

User Name
Input the user name used for WEB control of the connected projector. Set the user name set on that device.

Password
Input the password used for WEB control of the connected projector. Set the password set on that device.

Note
 z Specify the same network address for the Start IP Address and End IP Address. If the search range is too wide, an error 
will occur when you start the search.

 z In Network, multiple IP addresses and subnet masks are displayed in the list if your computer has multiple network 
interfaces. Select the address that is connected to the same network as the projector to be connected from the list.

 z Enter the user name and password of the account for accessing the device or the account with administrator privileges 
for the projector to be connected.
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Starting and Exiting the Application Starting the application

When not searching for a connected projector, click [Connect] after configuring the settings to display the data transfer method 
confirmation screen. Click the [OK] button on the screen to display the main screen.  

 “Adjustment and Settings – Main screen” (page 16)

Note
 z If the check box is selected on the data transfer method confirmation screen when you click the [OK] button, the 
confirmation screen will not be displayed subsequently.

When searching for a connected projector, click [Search] after configuring the settings to start the search according to the 
settings. The projector search screen is displayed while the search is in progress.

Cancel
Cancel the search.
When a search is canceled, projectors that have been 
detected up to that point will be displayed.

Connected projector list
Displays a list of projectors that were detected via the 
search.

Connect
Connect to the selected projectors, and display the data 
transfer method confirmation screen. Click the [OK] button 
on the screen to display the main screen.  "Adjustment 
and Settings – Main screen" (page 16)

Clear All
Clear selection of all detected projectors.

Select All
Select all detected projectors.

When [Exit] is clicked, the application is exited without establishing a connection.

Note
 z In the Connection Setting screen, both projectors connected via a device and projectors connected not via a device but 
directly are displayed together. In the projector list in “Common operation area” (page 24) of the main screen displayed 
after this, either only projectors connected via a device or projectors connected not via a device but directly are displayed.
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Starting and Exiting the Application Exiting the application

 � File connection
Select [  ] and configure the following settings.

File path
Specify a file (with .prjc or .prjs extension) saved in the past.
Click [Select] to open the file selection screen.

Click [Connect] after configuring the settings to display the data transfer method confirmation screen (page 14). Click the [OK] 
button on the screen to display the main screen.  “Adjustment and Settings – Main screen” (page 16)
When [Exit] is clicked, the application is exited without establishing a connection.

Note
The following screen appears when you connect to a projector for which the upgrade kit (ET-UK20) has not been applied. It 
does not appear when connected to a device.

Exiting the application
To exit the connection main screen, either select [File] and then [Exit] or click the  button at the top right of the window. 
To exit the connection settings screen, either click the [Exit] button or click the  button at the top right of the window. 
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Adjustment and Settings

Main screen
The main screen consists of the following five general areas and the [AUTO ADJUST] (Auto Screen Adjustment) button.

[AUTO ADJUST] 
(Auto Screen Adjustment) 

Main menu

Icon menu

Adjustment area

Common 
operation area

Status bar

Note
 z When connecting to a device to use this software, connect the power cable of the device to a power outlet to supply power 
and set the device to the operation state in advance. Also turn on the power and set the projection state for the projectors 
connected to the device. If the projectors are in the standby state, projection cannot be started by the [Power ON] operation 
of this software.

 z When connecting with a projector to use this software, turn on the main power of the projector and set the projector to the 
standby state.  
Projection can be started by the [Power ON] operation even when the projector is in the standby state. However, if the 
standby mode is set to [ECO] on a projector for which standby mode can be set, all operations including [Power ON] will 
be disabled. When using this application and performing the [Power ON] operation, set the projector’s standby mode to 
[Normal]. Operations other than [Power ON] are not guaranteed when the projector is in the standby state.

 z If the projector settings have been changed using a remote control, for instance, rather than the software application, the 
software application displays and projector settings may not match.
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Adjustment and Settings Main screen

Adjustment area
You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The modes in which these adjustments and operations are performed are called “editing modes.”
When “FMP series” is selected in the operation target selection drop-down list in the common operation area of the main 
screen, the tabs for the following editing modes are displayed, and the settings can be configured on each of the tabs. 

 “Common operation area” (page 24)
 z [Geometry]: Geometry correction
 z [Contents]: Content splitting
 z [Edge Blending]: Edge blending
 z [Black Level]: Black level adjustment
 z [Masking]: Masking
 z [Color Matching]: Color matching

When there are projectors connected without using a device and “Projectors” is selected in the operation target selection drop-
down list for the projector list, the tabs of the following editing modes are displayed, and the settings for the projectors can be 
configured on each of the tabs. For details on each of the functions, refer to the operating instructions for “Geometry Manager 
Pro Ver.6.7.”

 z [Lens Setting]: Lens setting
 z [Geometry]: Geometry correction
 z [Edge Blending]: Edge blending
 z [Uniformity]: Uniformity (correction of the unevenness in color and brightness within the screen)
 z [Brightness Control]: Brightness control (adjustment of each projector to make the brightness consistent)
 z [Color Matching]: Color matching / color adjustment
 z [Masking]: Masking
 z [Input Signal]: Input signal adjustments (selection of format matching the input signals and adjustment of position)
 z [Others]: Projector menu settings
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Adjustment and Settings Main screen

Main menu

 � File submenu
Open File (Current Tab)

This loads only the setting data of the current editing mode from a setting file (with .prj extension) saved on the 
computer. However, when the editing mode is Geometry or Contents, the setting data of both editing modes is loaded 
by this item.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Open File (One Projector)

This loads all the editing mode settings from the setting file (with .prj extension) saved on the computer into the selected 
device or projector.
When this menu item is selected, the loaded settings are reflected in the target device or projector even if 

 (at the bottom of the common operation area) has not been checked. 
 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Note
When the setting file is loaded, the settings may not be reflected correctly if the selected input signal is not the same as 
the one when the setting file was saved.

Open File (All Projectors)
This loads a file saved with [Save File (All Projectors) As...].
When this item is selected, the loaded settings are reflected in all the target devices or projectors that are connected 

even if  (at the bottom of the common operation area) is not checked.
 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message. 

Note
When the file is loaded, an error message is displayed if the target device or projector is not connected to the network. 
When the connection of the target device or projector to the network is recognized, the connection is established and 
the loaded settings are reflected automatically. 

Open File (Connection Only)
This loads a setting file (with .prjc or .prjs extension) saved to the computer and reflects the status of the connection 
with the saved device or projector.

Note
 z When the file is loaded, an error message will be displayed if the target device or projector is not connected to the 
network, but a connection will be established automatically when the computer recognizes that the target device or 
projector is connected to the network.

 z Even if a setting file (with .prjs extension) is selected, the settings of the device or projector target for connection are 
not reflected.

Save File (One Projector)
This saves the settings being edited, overwriting the previous settings in the current setting file (with .prj extension).
When the file is saved for the first time, a message appears prompting the user to provide a filename.

Save File (One Projector) As... 
This saves the settings now being edited in a file under the filename (with .prj extension) provided.

 z When connected with a device, a folder with the following name is created in the folder in which the setting file (with 
.prj extension) is saved, and an adjustment data file (with .obj or .png extension) is saved for each editing menu 
under that folder.
“(character string of name)_manualSettingData”
When the prj file is moved or copied, it needs to be moved or copied together with the folder in which this 
adjustment data file was saved.

Save File (All Projectors) As... 
This saves the setting information of all the currently connected devices or projectors as a single All Project File (with 
.prjs extension) on the computer.
The layout information, IP addresses, user names, and passwords of the devices or projectors are also encrypted and 
saved in the All Project File.
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Adjustment and Settings Main screen

Save File (Connection Only) As...
This saves the connection information of all the currently connected devices or projectors as a single file (with .prjc 
extension) on the computer.
The IP addresses, user names, and passwords of the devices or projectors are also encrypted and saved.

 z When connected with a device, a folder with the following name is created in the folder in which the setting file (with 
.prjs extension) is saved, and an adjustment data file (with .obj or .png extension) is saved for each projector and 
each editing menu under that folder.
“(character string of name)_manualSettingDatas”
When the prj file is moved or copied, it needs to be moved or copied together with the folder in which this 
adjustment data file was saved.

Reset Data (Current Tab)
This sets the current editing mode settings to the initial statuses.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Reload (Current Tab)
This cancels the settings currently being edited using this software, and loads the same settings again from the device 
or projector. However, when the editing mode is Geometry or Contents, the setting data of both editing modes is loaded 
by this item.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Activation 
Export Equipment Profile (ET-UK20 / ET-CUK10 / ET-CUK10P)
Activate License (ET-UK20 / ET-CUK10 / ET-CUK10P)

 �These are items that are used when connecting with a projector to make adjustments without using a device. For 
details, refer to the operating instructions for “Geometry Manager Pro Ver.6.7.”

Export
Multi Monitoring and Control Software
This saves the data in the file format (with .ugk extension) used for the “Multi Monitoring & Control Software”.
The file is for registering the data of a projector registered by connecting not via a device but directly from this software 
in “Multi Monitoring & Control Software” for monitoring and control purposes. For details, refer to the Operating 
Instructions of “Multi Monitoring & Control Software”. When connected to a projector via a device, registering a file 
output from this function in “Multi Monitoring & Control Software” for monitoring purposes is not possible.

Key Config
This configures the key settings for using a gamepad to operate some functions of this software for a projector 
connected not via a device but directly from this software. For details, refer to the operating instructions for “Geometry 
Manager Pro Ver.6.7.” When connected to a projector via a device, operation by gamepad is not possible.

Exit
Exits the software.

 z When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
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Adjustment and Settings Main screen

 � Edit submenu
Undo

This discards the software and device or projector settings currently being edited.
It returns these settings to the state before the setting data is sent.

Redo
This returns the settings to the ones before the Undo operation is performed.

Note
 z Undo and Redo can be used up to 50 times during a single setting process (for each editing mode).
 z The Undo and Redo logs are cleared if you switch to another editing mode or to another device or projector.

When connected to a projector via a device, the following Edit submenu items are enabled only in certain editing modes. 
For details, refer to the respective reference pages.

Lock
 “Adjustment and Settings − Geometry Correction” (page 32)

Unlock
 “Adjustment and Settings − Geometry Correction” (page 32)

Free
 “Adjustment and Settings − Geometry Correction” (page 32)

Reset
   “Adjustment and Settings − Geometry Correction” (page 32), “Adjustment and Settings − Black Level Adjustment” 
(page 61), “Adjustment and Settings − Masking” (page 68) 

Flip Vertical
   “Adjustment and Settings − Geometry Correction” (page 32), “Adjustment and Settings − Black Level Adjustment” 
(page 61), “Adjustment and Settings − Masking” (page 68) 

Flip Horizontal
   “Adjustment and Settings − Geometry Correction” (page 32), “Adjustment and Settings − Black Level Adjustment” 
(page 61), “Adjustment and Settings − Masking” (page 68) 
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Adjustment and Settings Main screen

 � View submenu
Tool Bar, Status Bar, Sub Window, Layout Window

Enter a check mark, and select whether the items are to be displayed.
In the initial status, “Tool Bar” and “Status Bar” are displayed.

Display Theme
Dark Gray / Light Gray
These switch the theme (color scheme) of this software.

Live View
This displays live view images.

 “Live View” (page 99)

Auto Transfer
When a check mark is entered for this and then settings are changed, the changed settings are reflected in the device 
or projector as soon as they are changed.
The state when this software is exited will continue when the software starts next time.

 z Entering a check mark causes a check mark to appear in  in the lower left of the common operation 
area.

Image Direction
Landscape / Landscape (Flipped) / Portrait (Clockwise) / Portrait (Counterclockwise)
Switch this to match the direction of images projected by the device or projector and the display in this software.

 “Adjustment and Settings - Geometry Correction - Geometry screen” (page 32)
 “Adjustment and Settings - Edge Blending - Edge Blending screen” (page 52)
 “Adjustment and Settings - Black Level Adjustment - Black Level screen” (page 61)
 “Adjustment and Settings - Masking - Masking screen” (page 69)

Note
 z This setting is not linked with the portrait setting of the projector. Configure the portrait setting of the projector separately.
 z Set this setting individually for each connected projector.

Line Color
White / Red / Green / Blue
When connected to a projector not via a device but directly from this software, these perform the same operations as 
the [White], [Red], [Green] and [Blue] icon menus on the Geometry screen. When connected to a projector via a device, 
they are grayed out and cannot be operated.

 “Adjustment and Settings - Geometry Correction - Geometry screen” (page 32)

Coordinate Information
None / Absolute / Relative
These select the mode in which the coordinates of the control points are displayed.

 “Adjustment and Settings - Main screen - Coordinate Information” (page 30)

Grid Resolution
Use Square Grid / X / Y
These select the mode in which the coordinates of the control points are displayed.

 “Adjustment and Settings - Geometry Correction - Geometry screen” (page 32)

Zoom
x1/8 / x1/4 / x1/2 / x1 / x2 / x3 / x4 / x5 / x6 / x7 / x8
The editing area is zoomed in or out.

Note
 z Zooming in with the screen display of content splitting is up to x2.

Masking Marker
Red / Green / Blue / Orange
These select whether to display the control points.

 “Adjustment and Settings - Masking - Masking screen” (page 69)
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 � Tools submenu
Command Control

When connected to a projector not via a device but directly from this software, the Command Control screen can be 
displayed. When connected to a projector via a device, they are grayed out and cannot be operated.

Auto Screen Adjustment
This displays the Auto Screen Adjustment screen.
This performs the same operation as the [AUTO ADJUST[ (Auto Screen Adjustment) button.

 “[AUTO ADJUST] (Auto Screen Adjustment) button” (page 31)

 � Version submenu
About Geometry... 

This displays version information for “Geometry Manager Pro for FMP series”.
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Icon menu
This icon menu is used in all the editing modes.
For details on the icon menu items used in each editing mode, refer to the description of the mode concerned.

 Open File (One Projector)

This performs the same operation as [Open File (One Projector)] on the File submenu.

 Save File (One Projector)

This performs the same operation as [Save File (One Projector)] on the File submenu.

 Reload (Current Tab)

This performs the same operation as [Reload (Current Tab)] on the File submenu.

 Undo

This performs the same operation as [Undo] on the Edit submenu.

 Redo

This performs the same operation as [Redo] on the Edit submenu.

 Layout Window

Each time this is clicked, the Layout Window screen is switched between displayed and cleared.
On the Layout Window, the positions of the projectors can be changed by means of mouse operations.
When a projector position is moved, the overall layout is automatically corrected based on the projector which was moved.
Main screen operations can be performed even while the Layout Window is displayed.
The Layout Window screen can be displayed also by selecting [Layout Window] on the View submenu.
The Layout Window screen below is an example when eight projectors are connected.

Selection area
The projector layout is displayed.
You can change the active projector by clicking one of the rectangles 
representing the projectors.
The frame of the selected projector is indicated in red.

OK
Click to apply the layout displayed in the selection area and close the 
screen.

Cancel
Click to close the screen without applying the layout displayed in the 
selection area.

Apply
Click to apply the layout displayed in the selection area.
The screen is not closed.

 Reset Data (Current Tab)

This performs the same operation as [Reset Data (Current Tab)] on the File submenu.

 Open File (Current Tab)

This performs the same operation as [Open File (Current Tab)] on the File submenu.
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Common operation area
The common operation area houses the operations which can be used in all the editing modes.

Projector list
This list displays the projector numbers, projector names and IP addresses in the 
sequence in which the projectors were connected.
The projector currently selected is the one whose data is being edited. Any projector on 
the list can be selected to switch the projector whose data is to be edited.

Note
 z When “FMP series” is selected in the operation target selection drop-down list, the 
names of the connected projectors (in the format of “FMP host name_<1 to 4>”) and 
the IP addresses set by the device are displayed.

 z Multiple projectors can be selected as targets for operations by holding the Ctrl 
key while clicking. In that case, the functions that can be operated differ as follows 
depending on the selection in the operation target selection drop-down list.
When FMP series is selected in the operation target selection drop-down list:
Test Pattern, Display Projector Name, DisplayGrid Lines
When Projectors is selected in the operation target selection drop-down list:
Test Pattern, Display Projector Name, Grid Resolution, Display Grid Lines, Power 
ON/Standby, Shutter Close/Shutter Open, OSD ON/OSD OFF, Status ON/Status 
OFF, Status Page

 z If connected directly with a projector for which the upgrade kit (ET-UK20) has not 
been applied when Projectors is selected in the operation target selection drop-down 
list, an asterisk (*) appears to the left of that projector name. An error message will 
appear if you connect to this projector and attempt to use the extended functions.  

 “Activation” (page 10)
 z When a projector on the list is selected and then double-clicked, the WEB control 
screen of the device or projector opens. For details on the WEB control screen, refer 
to the operating instructions of that device or projector.

 z When the mouse pointer is placed over a projector on the list, a tooltip appears and 
shows the model number and resolution of that projector.

 z If you change the projector authentication information (user name, password, etc.) 
by WEB control after connecting the projector to this software, you will lose ability to 
connect to or control the projector using this software.
In that situation, right-click on the projector in the list, select [Property], open the 
[Property] screen, and correct the authentication information. 

 “[Property] Screen” (page 26)

Operation target selection drop-down list
The projectors connected via a device and the projectors connected directly by LAN are 
displayed separately. Click and switch the projectors to be the operation targets. The 
projector list displays the projectors in accordance with this setting.

FMP series: Displays a list of projectors connected via a device.
Projectors: Displays a list of projectors connected not via a device but directly.

When a projector that is connected to a device is also connected by LAN to make lens 
and other adjustments, select “Projectors” to display it in the list, select the projector be 
set in that list, and make the adjustments. 

Note
 z With “Auto Screen Adjustment” (page 76), the function selection menus are 
displayed in accordance with this selection.
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Add
Click to display the LAN connection destination selection screen and add a new 
projector.

   “Adjustment and Settings − Main screen − LAN connection destination selection 
screen” (page 27)

Del
Click to remove the selected projector from the operating targets. 
When all the projectors are removed, the software is exited.

Rename
When connected to a projector via a device, the name of the projector cannot be 
changed.
When connected to a projector not via a device but directly, the name of the projector 
can be changed.
A name can consist of a maximum of 12 characters including letters (upper-case), 
numbers, hyphens and periods.

Display Projector Name
Click to display the name and number of the currently selected projector on the image 
projected by the projector.

 / 
These change the order of the projectors in the list.
Select a projector in the list and then click the up arrow button to move it up one place in 
the list or click the down arrow button to move it down one place in the list.

Note
 z Multiple projectors cannot be moved at the same time.
 z When the up arrow button is clicked while the very top projector is selected or when 
the down arrow button is clicked while the very bottom projector is selected, the 
projector does not move.

 z The results of moving the projectors are reflected in Layout Window. 
 “Layout Window” (page 23)
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[Property] Screen

IP Address
Enter the IP address of the projector.

Port
Set the port number to be used for connecting to the projector.

User Name
Enter the user name to be used for connecting to the projector.

Password
Enter the password to be used for connecting to the projector.

Note
 z Enter the user name and password of the account for 
accessing the device or the account with administrator 
privileges for the projector to be connected.

Update
Update and reconnect using the entered information.

Cancel
Discard entered information.
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LAN connection destination selection screen
When  is clicked, the LAN connection destination selection screen is displayed.
Select the search method for the projector to be newly added, and establish a connection or perform a search. For details on 
the IP address to specify here, refer to “IP address to use when searching for a projector” (page 13).

IP Address
Select this to search by specifying the IP address of the projector to be 
connected.

Start IP Address:
Input here the IP address of the projector to be connected.
To search for a connected projector, enter an IP address to start 
searching.
End IP Address:
To search for a connected projector, select the check box and enter an 
IP address to end searching.

Note
 z Specify the same network address for the Start IP Address and End IP 
Address.

 z If the search range is too wide, an error will occur when you start the 
search.

Port
Set here the number of the port that is to be connected to the projector.
User Name
Input here the user name of the projector to be connected.
Password
Input here the password of the projector to be connected.

Note
 z Enter the user name and password of the user account for the device 
or the account with administrator privileges for the projector to be 
connected.

Network
Select this to search for a projector within the same network as your 
computer.

Note
 z Multiple IP addresses and subnet masks are displayed in the list if your 
computer has multiple network interfaces. Select the address that is 
connected to the same network as the projector to be connected from 
the list.

Exit
Click to cancel the connection with the projector and close the LAN 
connection destination selection screen.

Connect / Search
When not searching for a connected projector, connection to the projector 
will be established according to the entered settings.
When searching for a connected projector, the projector search will start 
according to the entered settings.
A status screen is displayed while the search is in progress.  "Starting 
and Exiting the Application − Projetor Search Screen" (page 14)
When the projector is connected successfully, the LAN connection
destination selection screen is closed.
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The following buttons displayed in this area are grayed out and cannot be used when a 
projector connected to a device is selected in the list.

 z Power ON/Standby
 z Shutter Close/Shutter Open
 z OSD ON/OSD OFF
 z Status ON/Status OFF
 z Status Page
 z Command Control

You can use any of the buttons when connected to a projector not via a device but 
directly from this software. For details, refer to the operating instructions for “Geometry 
Manager Pro Ver.6.7.”

Test Pattern
Click to switch the image projected from the projector to the test pattern. 
A test pattern supported by the selected projector can be selected.
If multiple projectors are selected, a test pattern commonly supported by the selected 
projectors can be selected.
Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in 

.

Note
When a projector connected to a device is selected, a user test pattern can be selected. 
The user test patterns are displayed in the selection options as “FMP series User 
Custom.”
A user test pattern can be registered in the Contents editing menu.

 “Content Splitting” (page 45)
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Image Direction
Click to select an option to match the direction of images projected by the projector and 
the display in this software.

Landscape: Display projected images as they are.
Landscape (Flipped): Rotate by 180 degrees (flip top/bottom and left/right).
Portrait (Clockwise): Display is rotated clockwise (90 degrees right).
Portrait (Counterclockwise): Display is rotated counterclockwise (90 degrees left).

Default value: Landscape

Note
This operation does not change the projector settings.
Set this individually for each connected projector.

Grid Resolution (horizontal)
The number of grids in the horizontal direction is selected here.

When a check mark is entered for  , the two grid resolutions 
(horizontal and vertical) become one, and the button for selecting the combination of 
the number of grids whose horizontal and vertical intervals are identical is selected. If 
there is no combination of the number of grids whose horizontal and vertical intervals are 
identical, this is disabled.
The number of grids that can be selected differs depending on the model and resolution 
of the selected projector.
When connected to a projector not via a device, the combinations that can be selected 
differ depending on whether or not the upgrade kit (ET-UK20) has been applied to the 
selected projector.

Grid Resolution (vertical)
The number of grids in the vertical direction is selected here.
The number of grids that can be selected differs depending on the model and resolution 
of the selected projector.
When connected to a projector not via a device, the upper limit for the number of grids 
differs depending on whether or not the upgrade kit (ET-UK20) has been applied to the 
selected projector.
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Display Grid Lines
The color of the grids to be projected is selected here.

OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in 

.

Cursor Information
When a check mark is entered for , the cursor indicating the position of 
the control point can be displayed on the projected image.

Note
The cursor appears only at the top left when the control point has been selected using a 
line or area. 
If a multiple number of control points have been selected, the cursor will be displayed 
only at the control point selected last.

Cursor

Coordinate Information
The mode in which to display the control point coordinates is selected here when grids 
have been set in one of the editing modes.

None: The coordinates are not displayed.
Absolute:  The coordinates with the top left control point used as the origin point are 

displayed alongside the control points.
Relative:  The coordinates with the initial position of the control point in the selected 

grid used as the origin point are displayed alongside the control points.

Note
If the grid intervals are narrow, the coordinates may not be displayed even when 
Absolute or Relative has been selected.

Manual Transfer
When this button is clicked, the edited settings are reflected in the projector.

When a check mark is entered in  , as soon as a setting is changed, that 
setting is reflected in the projector. 
The state when this software is exited will continue when the software starts next time.
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[AUTO ADJUST] (Auto Screen Adjustment) button
This allows automatic adjustment of geometry correction, edge blending, and black level to the shape of the screen through 
use of an externally connected camera.
Click the [AUTO ADJUST] button to display the Auto Screen Adjustment screen.

 “Auto Screen Adjustment” (page 76)

Status bar
This is where the progress made in the data transfer, error messages and expansion ratio of the editing area are displayed.
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Geometry Correction
Test patterns or grids are projected onto the screen and those parts of the image that look unnatural are corrected. 
By adjusting the number of grids or number of control points, the images can be made to look more natural. 
Use the mouse to make coarse corrections, and use the cursor keys on the keyboard or input numerical values to make fine 
corrections. 

 z Drag the control point with the mouse while holding down the Shift key to move it in either the horizontal or vertical 
direction. 

 z Select the control point and then press the cursor key to move it in increments of 1 pixel. Press the cursor key while 
holding down the Ctrl key to move it in increments of 0.2 pixel. Press the cursor key while holding down the Alt key to 
move it in increments of 4 pixels.

Note
 z When making adjustments for a projector connected not via a device but directly, refer to the operating instructions for 
“Geometry Manager Pro Ver.6.7.”

 z When the number of grids displayed during ongoing adjustments is reduced, the corrected grid information may be lost. 
It is recommended that a small number of grids be displayed first to make coarse adjustments and then a larger number of 
grids be displayed to make fine adjustments.

Geometry screen

⑦ ①②③ ④

⑤

⑥

①	 Zoom In
Zooms in to the editing area.

②	 Zoom Out
Zooms out the editing area.
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③	 White
This corrects the RGB color components as well when connected to a projector not via a device but directly.

Note
This may be disabled depending on the model. Also, when connected to a projector via a device, this item is grayed out 
and disabled.

④	 Red, Green, Blue
These correct only the component of the selected color when connected to a projector not via a device but directly.

Note
This may be disabled depending on the model. Also, when connected to a projector via a device, this item is grayed out 
and disabled.

⑤	 Editing Area
The image can be corrected by selecting the grid using the mouse.
The settings established in the operation area are also reflected in this area.
The outermost red frame indicates the maximum area which can be projected. 
The red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left when the 
Image Direction setting is Landscape, and the location where it is shown also moves depending on the Image Direction 
setting.

⑥	 Operation Area
This is where the buttons, slide bars, etc. used by geometry correction are displayed. 
The operations that they perform differ depending on which correction pattern has been selected.

 “Operation area” (page 35)

⑦	 Edit, View
The following menu items can be used on the Geometry screen.

Edit submenu
Lock

Locks the control points of the grids selected.

Note
A locked control point will not move even if the correction pattern has been changed.  
The lock will not be released even if the number of grids has been changed.

Unlock
Unlocks the control points that have been selected.

Free
Click to release the control point selection.

Reset
Click to return the selected control points to the initial status.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
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View submenu

Image Direction
Match the direction of the editing area to the images projected by the projector.
This performs the same operation as Image Direction in the common operation area.

Grid Resolution
Use Square Grid
This makes it possible to select the combination of the number of grids which can be selected when a check 

mark has been entered for  in the common operation area.

X
The number of grids in the horizontal direction is selected here.
This performs the same operation as Grid Resolution (horizontal) in the common operation area.

Y
The number of grids in the vertical direction is selected here.
This performs the same operation as Grid Resolution (vertical) in the common operation area.
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 � Operation area

① ② ③ ④

①	 Mode Switching
OFF: Disables geometry correction.
ON: Enables geometry correction.

②	 Moving Area
Set here the range of the effects exerted on the grids around the control points that have been dragged and moved.

③	 Smoothing
Correction using curves can be performed when a check mark is entered in .

Example when the check mark is entered Example when the check mark is not entered

④	 Display Switching
Click  to minimize the operation area; conversely, click  to maximize it.
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Selecting the control points
Select the Geometry screen and switch the mode to ON. The control points can now be selected.

 “Free Grid (Free-form correction)” (page 37)
Drag the control points to move them. The control points cannot be moved by selecting the lines.

A multiple number of control points can be selected 
by dragging and enclosing the points where the grids 
intersect.

The control points can be selected using lines by 
clicking the space between one point where the grids 
intersect and another such point.

The control points can be selected using a multiple 
number of lines by dragging and enclosing the 
spaces between one point where the grids intersect 
and another such point.

When a point where the grids intersect is clicked, it 
can be selected as a single control point.

By clicking (or dragging) while holding down the Ctrl key, another control point can be selected while the currently selected 
control point keeps selected.
To move the selection to the adjacent control point, press the Tab key or Shift + Tab keys while one control point is selected, or 
press the cursor key while holding down the Shift key.
To cancel the selection of the control point, click anywhere other than the grid with the mouse or select [Free] in the Edit 
submenu displayed by right-clicking.

Right-clicking
The menu with the items described below is displayed when a grid control point is selected and the right button of the mouse 
is clicked.
The menu functions are the same as with the Edit submenu.

 “Edit submenu” (page 33).

Lock, Unlock, Free, Reset, Flip Vertical, Flip Horizontal
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Free Grid (Free-form correction)
The Free Grid operation area is where the operations for all the correction patterns are selected.
The corrections made with Free Grid are also reflected in the editing area of the other correction patterns. You can 
superimpose corrections by selecting another correction pattern after making corrections with Free Grid, and then configuring 
the settings of each correction pattern.

①

①	 Correction Patterns
Any of the following correction patterns can be selected.

 z Free Grid (free-form correction)
 z 4 Corner (4-corner correction)
 z Keystone (keystone shape correction)
 z Cylindrical screen (cylindrical shape correction)
 z Elliptical screen (elliptical shape correction)
 z Spherical screen (spherical shape correction)
 z Rotation (rotational correction)
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4 Corner (4-corner correction)
The positions of the four corners of the image are set with this type of correction.

① ② ⑤

⑧

③ ④ ⑥ ⑤ ⑦ ⑨ ⑤

①	 Upper Left
Set the horizontal and vertical positions of the upper left.

②	 Lower Left
Set the horizontal and vertical positions of the lower left.

③	 Upper Right
Set the horizontal and vertical positions of the upper right.

④	 Lower Right
Set the horizontal and vertical positions of the lower right.

⑤	 Reset
Click these to reset the respective settings which have been changed.

⑥	 Rotation [degree]
Set the rotational angle of the image here.

⑦	 Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑧	 Linearity
Set the linearity in the horizontal and vertical directions.

When a check mark is entered for , the linearity values are determined automatically from the positions of the 
upper, lower, left, right, and four-corner points. In this case, values cannot be set. 

⑨	 Pincushion
Set the pincushion independently for upper, lower, left, and right.
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Keystone (keystone shape correction)
Images are corrected using the keystone shape as the reference with this type of correction.

④②③②①

①	 Correction pattern adjustment area
Select the settings for vertical, horizontal, vertical balance, and horizontal balance here.

②	 Reset
Use these to reset the settings that have been changed.

③	 Setting
Select the settings for Lens Throw Ratio, V Keystone, H Keystone, V Balance, H Balance, and Rotation here.

④	 Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.
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Cylindrical screen (cylindrical shape correction)
Images are corrected using the cylindrical shape as the reference with this type of correction.

④②③②① ⑤

①	 Correction pattern adjustment area
Select the settings for vertical arc and horizontal arc here.

②	 Reset
Use these to reset the settings that have been changed.

③	 Setting
Select the settings for Lens Throw Ratio, V Keystone, H Keystone, V Arc, H Arc, V Balance, H Balance, and Rotation 
here.

④	 Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑤	 Maintain Aspect Ratio
When a check mark is entered for  , correction is made so that the aspect ratio of the projected 
image is maintained. 
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the 
display device.
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Elliptical screen (elliptical shape correction)

Images are corrected to fit a screen whose shape is 
elliptical when viewed from above.

④ ⑤②③②①

①	 Correction pattern adjustment area
Select the settings for width/radius ratio, flattening, azimuth, and vertical balance here.

②	 Reset
Use these to reset the settings that have been changed.

③	 Setting
Select the settings for Lens Throw Ratio, V Keystone, H Keystone, Width/Radius Ratio, Flattening, Azimuth, V Balance, 
and Rotation here.

④	 Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑤	 Maintain Aspect Ratio
When a check mark is entered for  Aspect Ratio, correction is made so that the aspect ratio of the 
projected image is maintained. 
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the 
display device. 
This function can be used only for projectors that have this function.
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 � Description of elliptical screen (elliptical shape correction) parameters

View of projector as seen from above

Screen

Tangent Width/Radius Ratio

H Keystone [degree]
FlatteningAzimuth

Projector

Horizontal radius of 
ellipsis

Example of settings

Setting item Calculation method Setting
Lens Throw Ratio Projection distance ÷ width of image on flat screen

= 3 870 mm ÷ 4 300 mm
0.9

H Keystone [degree] Angle formed with tangent of projection center 14.0
Width/Radius Ratio Width of image on flat screen ÷ radius in horizontal direction of ellipsis

= 4 300 mm ÷ 6 200 mm
0.69

Flattening Radius in vertical direction of ellipsis ÷ radius in horizontal direction of ellipsis
= 4 110 mm ÷ 6 200 mm

0.66

Azimuth Position of projected image center on ellipsis 40.0

Screen

Tangent 4 300 mm

14°
4 110 mm

40°

Projector

6 200 mm

3 
87

0 
m

m
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Spherical screen (spherical correction)
Images are corrected using the spherical shape as the reference with this type of correction.

④ ⑤②③②①

①	 Correction pattern adjustment area
Select the settings for vertical arc and horizontal arc here.

②	 Reset
Use these to reset the settings that have been changed.

③	 Setting
Select the settings for Lens Throw Ratio, V Keystone, H Keystone, V Arc, V Balance, H Balance, and Rotation here.

④	 Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.

⑤	 Maintain Aspect Ratio
When a check mark is entered for , correction is made so that the aspect ratio of the projected 
image is maintained. 
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the 
display device. 
This function can be used only for projectors that have this function.
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Rotation (rotation correction)
Images are rotated with this type of correction.

④②③②①

①	 Correction pattern adjustment area
Select the setting for the gradient here.

②	 Reset
Use these to reset the settings that have been changed.

③	 Setting
Select the setting for the gradient here.

④	 Fit Size
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for  , the image is reduced to a size in which it can be projected when it exceeds 
the projection area.
The image will not be reduced if a check mark is not entered.
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Content Splitting
When projecting one content image as a multi-screen by joining the projection screens of multiple projectors connected to a 
device, set which part of the content image to split and assign to each projector screen.

 � Projector Mode
First, set the size, position, and projection angle for each of the projector screens in the multi-screen within the editing area 
while checking the actual projected image.

 � Content Mode
Then, make adjustments so that the content is projected in the multi-screen as intended by setting the size, position, and 
projection angle of the content images to be arranged in the multi-screen while checking the actual projected image by 
overlaying it on the projector screen layout set in the editing area.

These adjustments set the setting information to determine which part of a content image to split and which position and at 
what zoom ratio and angle to project it in the projection screen on the device with each of the projectors connected.

Note
If Auto Screen Adjustment (geometry correction and edge blending) is performed, content splitting adjustment is performed as 
well, but additional adjustments cannot be made with respect to those results from this menu. If this menu is selected while the 
results of Auto Screen Adjustment are applied, a dialog box appears to confirm whether to discard the results of Auto Screen 
Adjustment and then continue with setting. To perform content splitting again manually, click [OK] and continue the operation 
of this menu.
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Contents screen

 � Projector Mode

②⑧⑦

③ ⑤

①

④ ⑥

①	 Switching mode for editing
When setting the size, position, and angle of each projector screen, click the [Projector Mode] button. The projector 
selected in the projector list is the setting target.

②	 Editing area
This displays the projector screen of each projector with a device connected as a white line rectangle with the number in 
the projector list displayed at the top left corner. Construct a multi-screen by selecting the projectors in the projector list 
and setting the size, position, and shape of each of them with the following procedure.

In the initial state, the projection screen of each projector is displayed 
overlapped as shown in the figure on the left.
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The projection screen of the projector selected in the projector list is displayed as a red frame including control points as 
shown in the figure below. The position can be moved by clicking with the mouse inside the red frame in this state and 
then dragging.

The projection screen of the projector can be enlarged, reduced, or transformed by dragging a control point on the red 
frame.

 z The positioning, enlargement, and transforming of the projection screen can be finely adjusted by entering numerical 
values in the menus (Size and Position) below the editing area. In addition, the rotation of the projection screen can 
be set in the Rotate menu.

Dragging the four corners enlarges or reduces while 
maintaining the shape

Dragging the control point at the center of a side enlarges 
and reduces while transforming the rectangle

2 2

③	 Size
When enlarging or reducing the projection screen of the selected projector, set the number of pixels in the horizontal and 
vertical directions.
Change the size treating the top left vertex (vertex near the displayed number) of the projection screen as the fixed point.
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④	 Position
Specify the position of the projection screen of the selected projector by entering the coordinates (horizontal direction: X, 
vertical direction: Y) of the top left vertex (vertex near the displayed number) of the projection screen treating the top left 
corner of the editing screen as the origin (● of arrow in the figure below).

Origin point (0:0)

Coordinates (X:Y)

⑤	 Rotate
Rotate the projection screen of the selected projector treating the center of that rectangle as the axis.
Move the gauge from the center to the left to rotate it counterclockwise, and from the center to the right to rotate it 
clockwise.
The projection screen can also be rotated by entering an angle in the Angle field. In that case, enter a negative value to 
rotate it counterclockwise, and a positive value to rotate it clockwise.

⑥	 Reset
Cancel the size, position, and shape changes made to the projection screen of the selected projector to return to the initial 
state.

⑦	 Zoom In
Zooms in to the editing area. The maximum magnification ratio is x2.

⑧	 Zoom Out
Zooms out the editing area.
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 � Content Mode

⑪⑩

④

⑥

①

③ ⑤ ⑦ ⑧ ⑨

②

①	 Switching mode for editing
When setting the size, position, and projection angle of the content images to be arranged in the multi-screen constructed 
from the projection screens of multiple projectors, click the [Content Mode] button.

②	 Editing area
This area displays the content image screen overlaying the projection screen (white line rectangle with the projector 
number at the top left) of the projector. Make adjustments to achieve the intended multi-screen projection by setting the 
size, position, and shape with the following procedure while viewing the actual projected image.
The position of the content image screen can be moved by clicking with the mouse inside the red frame and then 
dragging. The content image screen can be enlarged, reduced, or transformed by dragging a control point on the red 
frame.
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 z The positioning, enlargement, and transforming of the screen can be finely adjusted by entering numerical values in 
the menus (Size and Position) below the editing area. The rotation of the projection screen can be set in the Rotate 
menu, and vertical or horizontal flipping of the image can be set in the Flip (Horizontal) and Flip (Vertical) menus.

Dragging the four corners enlarges or reduces while 
maintaining the shape

Dragging the control point at the center of a side enlarges 
and reduces while transforming the rectangle

Geometry Manager Pro Geometry Manager Pro

③	 User Custom Pattern
If you want to change the editing area during content splitting adjustment and the content image displayed during actual 
projection, you can register a user custom pattern to the device. Click [Add] or [Change] to display a screen for selecting 
image data for the content image.
To reflect the projection image, select all of the projectors in the projector list and then change Test Pattern to “FMP 
series User Custom.”

Specifications of supported image data:

File type
Maximum number 

of pixels
Other functions Extension

JPEG 4096×4096 Image format: baseline only
Animation: Unsupported
Color space : YUV420/YUV422/YUV444

.jpg

.jpeg

Bitmap Number of bits : 1bit, 4bit, 8bit, 24bit
Run-length encoding: Unsupported
Bit fields: Unsupported
Top to bottom: Unsupported
Transparent: Unsupported

.bmp

.png

png Number of bits: 24
Transparent: Unsupported

.png

Note
A test pattern that is registered with this function and then projected is displayed even if you move to another editing 
menu. To cancel display of the test pattern, perform the operation in the Test Pattern menu of the common operation 
area.

④	 Size
When enlarging or reducing the projection screen of the content image screen, set the number of pixels in the horizontal 
and vertical directions.
Change the size treating the top left vertex of the screen in the upright position as the fixed point. Even if the screen is 
flipped or rotated, this top left vertex remains a fixed point and does not change.

⑤	 Position
Specify the position of the content image screen by entering the coordinates (horizontal direction: X, vertical direction: Y) 
of the top left vertex of the screen treating the top left corner of the editing screen as the origin.
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⑥	 Rotate
Rotate the content image screen treating the center of that rectangle as the axis.
Move the gauge from the center to the left to rotate it counterclockwise, and from the center to the right to rotate it 
clockwise.
The content image screen can also be rotated by entering an angle in the Angle field. In that case, enter a negative value 
to rotate it counterclockwise, and a positive value to rotate it clockwise.

⑦	 Flip (Horizontal)
Horizontally flip the image displayed in the content image screen. If the content image screen is displayed rotated, it will 
be flipped in the horizontal direction of when there is no rotation.

ABC ABC ABC
⑧	 Flip (Vertical)

Vertically flip the image displayed in the content image screen. If the content image screen is displayed rotated, it will be 
flipped in the vertical direction of when there is no rotation.

ABC ABC

Note
Check marks can be placed in both Flip (Horizontal) and Flip (Vertical) at the same time.

⑨	 Reset
Cancel the size, position, and shape changes made to the content image screen to return to the initial state.

⑩	 Zoom In
Zooms in to the editing area. The maximum magnification ratio is x2.

⑪	 Zoom Out
Zooms out the editing area.
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Edge Blending
The screen joins can be corrected when constructing a multi-screen by joining the projection screens of multiple projectors 
that are connected via a device. The following two types of operation screen are available to use depending on the way in 
which multiple projectors are arranged.

 z The black level between multiple projectors connected to a device can be adjusted in the “Black Level Adjustment” editing 
menu.

 � Individual Mode
Use this mode when constructing a multi-screen by arranging multiple projectors aligned in either the vertical or horizontal 
direction or in both directions. Set the necessary joins at the top, bottom, left, and right of each projector by determining the 
start lines and end lines.

 � Multiple Mode
Use this mode when constructing a multi-screen by arranging multiple projectors in various directions (free layout). The 
joins of screens of a wide variety of shapes can be set.

Note
For details on the edge blending correction procedure when connected to a projector not via a device but directly from this 
software, refer to the operating instructions for “Geometry Manager Pro Ver.6.7.”

Edge Blending screen

 � Individual Mode
⑦⑨⑧

④

①

③

⑤② ⑥
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①	 Switching mode for editing
Select Individual Mode or Multiple Mode. A different editing mode cannot be set for each projector.

②	 ON/OFF of edge blending setting for each projector
OFF:
The edge blending settings are canceled.

ON:
Makes the edge blending settings effective.

③	 Edge Blend Marker
When this is set to ON, markers (lines) equivalent to those in the editing area are displayed on the images projected from 
the projector. A start line for edge blending is displayed as a dotted line, and an end line for edge blending is displayed as 
a solid line (for the line colors, refer to ④ ).

④	 Set Blending Line
Set the start lines and end lines for edge blending at the edges of joins in the projector projection area.

Left/Upper/Right/Lower:
Place check marks in those check boxes for the projection image edges that correspond to the edges to apply edge 
blending.

Start:
Set the starting position for edge blending.

End:
Set the ending position for edge blending.

The display colors of markers differ depending on the edges to be set in Edge Blend Marker. The setting details are as 
follows when shown in an organized manner.

Edge to set Left edge Top edge Right edge Bottom edge
Check box Left Upper Right Lower
Marker display color Red Blue Green Orange
Start position to set in 
Start

Distance of start line 
center point from left 
edge

Distance of start line 
center point from top 
edge

Distance of start line 
center point from right 
edge

Distance of start line 
center point from 
bottom edge

End position to set in 
End

Distance of end line 
center point from left 
edge

Distance of end line 
center point from top 
edge

Distance of end line 
center point from right 
edge

Distance of end line 
center point from 
bottom edge

⑤	 Set Blending Curve
Click this button to display the user-defined curve setting screen.

 “User-defined curve setting screen” (page 60)

⑥	 Recalc Edge Blending
This calculates the adjustment data to send to the device based on the settings of the area to perform the edge blending 
set in the editing area. The calculation results are displayed in the projector projection area within the editing area, and 
the brightness gradient is displayed as a grayscale image.
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⑦	 Editing area
Set the area to apply edge blending by operating the adjustment points on the displayed start lines (dotted lines) and end 
lines (solid lines) with the mouse. The settings configured in the operation area are reflected in this area.
The two end points of a line can be moved to any positions on the outer circumference of the projector projection area. An 
entire line can be moved by dragging the center point of the line.
An end point or center point selected on a line turns light blue, and its position can be finely adjusted by pressing the 
cursor keys.
If you right-click an end point of a line, the following menu items for performing line operations are displayed.

Enable Bezier:
Curves a start line or end line. The degree of bulge in the curve and the position of the vertex can be set by 
dragging to move the position of the light blue handle displayed while the corresponding point is selected. Use this 
function in cases such as setting an area to perform edge blending that matches curved screens.

Disable Bezier:
This cancels the line curving that was performed with the corresponding point. The curved line is returned to a 
straight line.

Drag the light 
blue handle.

⑧	 Zoom In
Zooms in to the editing area.

⑨	 Zoom Out
Zooms out the editing area.
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 � Multiple Mode

⑤

②③① ④

①	 Select ON/OFF and Marker Enable Projectors
Click this button to display the setting screen to set edge blending to ON/OFF and marker (line) display equivalent to that 
in the editing area on the images projected from the projector to ON/OFF for each projector.

 “ON/OFF setting screen of edge blending and marker display for projectors” (page 59)

②	 Set Blending Area
Specify the area in which to apply edge blending.
The combination of projectors displayed in the projector list is selected in the pull-down list. In the pull-down menu, all 
combinations of two projectors created from the projectors connected to the device are displayed in the format of sets of a 
number in the list and a projector name connected by a hyphen (e.g., “01 PROJECTOR1 - 02 PROJECTOR2”).
For all of these combinations, when you have selected a combination to create a join between the screens, place a check 
mark in the Enable check box and then set the range to apply edge blending in the editing area.
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When setting a join between two screens placed at the same angle in the horizontal direction, place a check mark in 
the Interlocked H check box and then set the edge blending range in the left screen. The edge blending range is set 
automatically also in the relative positions on the right screen.

Placement of screens Example of setting edge blending range in editing area

When setting a join between two screens placed at the same angle in the vertical direction, place a check mark in 
the Interlocked V check box and then set the edge blending range in the left screen. The edge blending range is set 
automatically also in the relative positions on the right screen.

Placement of screens Example of setting edge blending range in editing area

When setting a join between two screens that are misaligned both in the horizontal and vertical directions but placed at 
the same angle, place check marks in both of the Interlocked H and Interlocked V check boxes and then set the edge 
blending range in the left screen. The edge blending range is set automatically also in the relative positions on the right 
screen.

Placement of screens Example of setting edge blending range in editing area

When setting a join between two screens placed at different angles, remove the check marks from both the Interlocked H and 
Interlocked V check boxes and then set the edge blending range in the screens on each of the left and right. If necessary, 
add control points to the object with [Add point] and then change the position of each control point according to the shape of 
the join. For the control points in the four colors of red, blue, green, and orange (control points except points added with Add 
point) on the left and right screens, make sure that the control points of each color are placed in overlapping positions.

Placement of screens Example of setting edge blending range in editing area
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When setting of the edge blending range is finished for the selected projector combination, click the Set button. This adds 

the  mark to the display of this combination in the pull-down menu.
If the setting of a join for the selected projector combination is not necessary, remove the check mark from the Enable 

check box and then click the Set button. This adds the  mark to the display of this combination in the pull-down menu. 
Objects to indicate the edge blending area are not displayed in the editing area for a combination with the check mark 
removed from the Enable check box.

Repeat this operation until the  mark is added to all of the projector combinations in the pull-down menu.

③	 Set Blending Curve
Click this button to display the user-defined curve setting screen.

 “User-defined curve setting screen” (page 60)

④	 Recalc Edge Blending
This calculates the adjustment data to send to the device based on the settings of the area to perform the edge blending 
set in the editing area. The calculation results are displayed in the projector projection area within the editing area, and 
the brightness gradient is displayed as a grayscale image.

If the  mark is not added to all combinations in the pull-down menu of ② Set Blending Area, this button is grayed out 
and cannot be operated by clicking.

⑤	 Editing area
This area displays the screens of the two projectors of the combination selected in the pull-down menu of ② Set Blending 
Area arranged on the left and right. If a check mark is added to the Enable check box for that combination, objects with 
control points in four colors, red, blue, green, and orange, are displayed in the editing area. Specify the range to perform 
edge blending by changing the placement of the objects and transforming them by dragging these control points to move 
them. The selected control point is displayed in light blue, and its position can be finely adjusted with the cursor keys 
(moved one pixel at a time). If you operate a cursor key while holding down the Alt key, the control point will move four 
pixels at a time.
If a check mark is placed in the Interlocked H or Interlocked V check box in ② Set Blending Area, moving or transforming 
only the left screen (screen with the red frame) applies the same setting also to the object of the right screen.
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Right-clicking
If you right-click on an edge or point of an object, the following menu items are displayed.

Add Point
Add a control point to the right-clicked position. The color of ■ of a control point is bright red in the left screen, 
and bright green in the right screen. The number of points that can be added is only one between the four points 
in red, blue, green, and orange of an object in the initial state. Use this function when setting a complicated join 
shape for screens at different angles.

Delete Point
Delete an added control point. The four points in red, blue, green, and orange of an object in the initial state 
cannot be deleted. Even if you right-click these points, Delete Point will be grayed out and cannot be selected.

Enable Bezier
If you right-click a control point and then select this item, the two straight lines to the adjacent control points 
become curved and the degree of that bulge and the position of the vertex can be set by operating the two light 
blue handles that are displayed. Use this function when, for example, setting an area to perform edge blending 
that matches curved screens.

Disable Bezier
Cancel the curving that was performed by Enable Bezier. The curved line is returned to a straight line.

Setting example of Enable Bezier when check mark is placed in the Interlocked V check box

Right-click this control point and 
then select [Enable Besier].

Dragging the left handle of the two displayed 
light blue handles allows you to transform the 
curve between it and the left control point.

By configuring the settings on the left screen, 
the corresponding line on the right will also be 
transformed into a shape that is symmetrical 
vertically.
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ON/OFF setting screen of edge blending and marker display for projectors
When you click [Select ON/OFF and Marker Enable Projectors], this screen appears. In this screen, set edge marking to ON/
OFF and marker (line) display on the images projected from the projector to ON/OFF for each projector.

①②

④

③

⑤

①	 List of projectors connected to the device
This list displays ON/OFF of edge blending, ON/OFF of marker (line) display, projector name, and IP address of each 
projector, as well as the model number of the device.

②	 Projector edge blending ON/OFF check box
Place check marks in the check boxes of the projectors for which to perform edge blending.

③	 Select ON All / Clear ON All
Use these buttons to place check marks in all projector edge blending ON/OFF check boxes at once, and remove the 
check marks from all of them at once.
Place check marks for all projectors by clicking Select ON All, or remove the check marks for all projectors by click Clear 
ON All.

④	 Edge Blend Marker of the selected projector
Set marker (line) display to ON/OFF for the projector selected by clicking in the projector list.

⑤	 OK
Set the configured settings in the device and close this screen.
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User-defined curve setting screen
When [Set Blending Curve] is clicked, the user-defined curve setting screen is displayed.
The gradient (brightness gradient) at which edge blending is performed is set using a gamma curve.

①

③

⑥

②

④

⑤

⑦

①	 Blending
The position where the user-defined curve is to be set is selected here.
When the user-defined curve setting screen is opened in Multiple Mode, this item is not displayed.

②	 Gamma
The user-defined curve is set here.
For numerical value input: Enter a setting from 0.25 to 4.00 (in 0.01 steps).

③	 Initial Curve
The initial setting of the user-defined curve is displayed here.

④	 Correction Curve
The operation point in the center can be dragged to change the user-defined curve setting (shape of the gamma curve).

⑤	 Reset
Click this to reset the currently displayed user-defined curve setting and return it to the initial value.

⑥	 OK
Click this to reflect the user-defined curve setting and close the user-defined curve screen.
The result of this operation is reflected in the calculation when the [Recalc Edge Blending] button is clicked.

⑦	 Cancel
Click this to cancel the setting and close the user-defined curve screen.
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Black Level Adjustment
If an image that is completely black is projected when a multi-screen has been constructed by joining the projection screens 
of multiple projectors, a screen join part may become brighter than other parts or differences in the brightness of black may 
be visible between projectors. By adjusting the black level, you can change the brightness level and coloring when black is 
projected onto any area of the projection screen of the projector, making the difference in black level less noticeable.

Black Level screen

⑧ ① ③②

④
⑤

⑥ ⑦
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①	 Zoom In
Zooms in to the editing area.

②	 Zoom Out
Zooms out the editing area.

③	 Editing area
Click the operation points to select them, and then drag them to set the position and shape of the area in which to adjust 
the black level.
The outmost red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left 
when the Image Direction setting is Landscape, and the location where it is shown also moves depending on the Image 
Direction setting.
The inner white frame displays the projection screen of the projector. The black level adjustment data that was loaded 
with Open File or loaded from the device is displayed in the projection screen, and if the black level adjustment area is 
already set, that part is displayed in the set brightness and color. These settings can be left as they are and a new black 
level adjustment area can be added using [Add Polygon] described later, or another black level adjustment area can be 
added by overlaying it on these settings and then the brightness can be adjusted. If you want to discard the loaded black 
level settings, execute [Reset Data (Current Tab)] on the File submenu.

④	 Mode switching
OFF
Black level adjustment is not performed.

ON
Black level adjustment is enabled.
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⑤	 Object Parameter - Area Select
Add Polygon
Click this to add a rectangular black level adjustment area to the center of the projected image. You can click in the 
area with the mouse and then move, transform, or otherwise modify the black level adjustment area with the mouse 
or cursor keys. In addition, you can set the coloring and brightness of that area by using ⑥ Solid Painting from that 
state.

Black level adjustment operations
When you click [Add Polygon], a rectangular black level adjustment area is added to the center of the projected 
image. When you click to select the black level adjustment area, control points are displayed at the four corner 
vertices of the black level adjustment area.

You can drag the black level adjustment area, or press the cursor keys to move it up, down, left, or right.

If you click a control point, that control point turns light blue. You can change the shape of the black level 
adjustment area by dragging the light blue control point or pressing the cursor keys.

Note
Each press of a cursor key moves the control point by 1 pixel. Pressing the cursor key while holding down the Alt 
key moves it in increments of 4 pixels.
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Right-clicking
If you right-click on the outer circumference of the black level adjustment area, the following menu items are 
displayed.

Add Point
Add a control point to the right-clicked position. Up to 16 control points can be added to the outer 
circumference of each black level adjustment area.

Delete Point
Delete an added control point. However, when a rectangular black level adjustment area was added with 
[Add Polygon], the four points that were available from the beginning cannot be deleted.

Enable Bezier
If you right-click a control point and then select this item, the two straight lines to the adjacent control points 
become curved and the degree of that bulge and the position of the vertex can be set by operating the two 
light blue handles that are displayed.

Disable Bezier
Cancel the curving that was performed by Enable Bezier. The curved shape is returned to the original 
straight line.

Delete Polygon
Click this to delete the currently selected black level adjustment area.

Reset
Click this to reset the brightness and coloring settings (Solid Painting described later) of the currently selected black 
level adjustment area.



65

Adjustment and Settings Black Level Adjustment

⑥	 Object Parameter - Solid Painting
When setting the coloring for the black level adjustment area specified using Add Polygon, change the color level of each 
of R (red), G (green), and B (blue) while switching the selection between the following [Independent], [Matched], and 
[Linked].

Independent
Change the coloring by setting the levels of R (red), G (green), and B (blue) independently.

Matched
Simultaneously change the levels of all three colors by matching them to a change made to any one of the levels 
of R (red), G (green), and B (blue). If any one of the levels is changed, the setting values of the other two levels are 
made the same automatically.

Linked
Simultaneously change the levels of all three colors while retaining the differences in the levels set for R (red), G 
(green), and B (blue). If any one of the levels is changed, the differences in the setting values before the change are 
retained as is and the other two levels are also changed automatically.

Brightness
When setting the brightness for the black level adjustment area specified using Add Polygon, select [Brightness] 
in the pull-down menu, and increase or decrease the brightness level with the gauge or by numerical value input in 
[Brightness] at the bottom.

Note
Only either a coloring setting (Independent, Matched, or Linked) or the brightness setting (Brightness) can be configured 
for a black level adjustment area.
If you want to change the brightness of part of the area displayed within the editing area of the loaded black level 
adjustment data or change the brightness of an area containing the black level adjustment area for which the coloring 
was configured, place a new black level adjustment area over that area and then configure the brightness setting.

⑦	 Viewer Parameter
This displays information about the black level adjustment level at the mouse cursor position.
Example: x=1636, y=116, R=335, G=35, B=35

Values of x and y
The coordinates of the mouse cursor within the projection screen (inside the white frame) indicate the pixel values in 
the horizontal direction: x and vertical direction: y with the origin at the top left corner of the white frame.

Values of R, G, and B
The black level adjustment levels at the position of the mouse cursor within the projection screen (inside the white 
frame) indicate the color levels of R (red), G (green), and B (blue).

View Brightness
By increasing the setting value of View Brightness, you can highlight small changes in coloring or brightness 
within the black level adjustment area to make them more visible in the editing area. Increasing the value makes 
the display of smaller level (dark level) changes brighter (increases the contrast). This setting is applied only to the 
editing area. It has no effect on the coloring and brightness of projected images.
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⑧	 Edit, View
In addition to the menu items described in “Main menu” (page 18), the following menu items can be used on the Black 
Level screen.

Edit submenu

Reset
Click to delete all of the set black level areas (areas added to the editing area by [Add Polygon]).

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
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Color Matching
When constructing a single image using multiple projectors connected to a device, the coloring of the images projected from 
the projectors may not match. If this is the case, you can match the coloring by adjusting the images from the device that are 
input to the projectors.

Note
For details on the color matching / color adjustment procedure when connected to a projector not via a device but directly from 
this software, refer to the operating instructions for “Geometry Manager Pro Ver.6.7.”

Color Matching screen

①

②

③

①	 Mode
The color matching mode is selected here.

OFF
Color matching is not performed.

3 Colors
The inconsistencies in the colors are corrected by adjusting three colors (Red, Green and Blue).

7 Colors
The inconsistencies in the colors are corrected by adjusting seven colors (Red, Green, Blue, Cyan, Magenta, Yellow 
and White).

②	 3 Colors
The Red, Green and Blue values are set here.
The brightness of the 3 colors can be adjusted at the same time by changing the White value.
The settings take effect when [3 Colors] has been selected as the Mode setting.
The changes can be returned to the initial values (standard values) by clicking the [Reset] button.

Note
When saving to a setting file or reflecting settings in the device is performed, each value of Red, Green, and Blue is 
applied treating the setting value of White as the adjustment coefficient (for example, when White is 128, each of Red, 
Green, and Blue becomes 1/2). When these settings are loaded, the value of White always becomes 255.

③	 7 Colors
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here. 
The settings take effect when [7 Colors] has been selected as the Mode setting.
The changes can be returned to the initial values (standard values) by clicking the [Reset] button.
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Masking
Two kinds of masking are available.

Note
For details on the masking settings when connected to a projector not via a device but directly from this software, refer to the 
operating instructions for “Geometry Manager Pro Ver.6.7.”

 � Line Masking
The shape to be masked is set by moving the operation points on the four sides–top, bottom, left and right–of the projected 
image.
The area to be masked can also be inverted between positive and negative.

 � Custom Masking
A freely-shaped mask can be set at any position on the projected image by transforming a polygon or ellipse. The area to 
be masked can be inverted between positive and negative or the center part can be masked fully and processing can be 
applied to increase the transmittance toward the periphery.
In addition, you can change the position and size by loading a bitmap in 1-bit monochrome format and setting it as the 
masking data.
Bitmaps from 8 x 8 pixels to 1 920 x 1 080 pixels (when the resolution of the projector connected to the device is 1 920 x 
1 080 dots) or 3 840 x 2 160 pixels (when the resolution of the projector connected to the device is 3 840 x 2 160 dots) are 
supported.
Files with the *.bmp and *.dib extensions are supported.
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Masking screen

①⑨

⑧

② ④⑤⑥ ⑦③

①	 Zoom In
Zooms in to the editing area.

②	 Zoom Out
Zooms out the editing area.

③	 Red
Selects whether the operation points on the left side of the projected image are to be displayed or not displayed.
This performs the same operation as [Mask Marker] – [Red] on the View submenu.

④	 Blue
Selects whether the operation points at the top of the projected image are to be displayed or not displayed.
This performs the same operation as [Mask Marker] – [Blue] on the View submenu.

⑤	 Green
Selects whether the operation points on the right side of the projected image are to be displayed or not displayed.
This performs the same operation as [Mask Marker] – [Green] on the View submenu.

⑥	 Orange
Selects whether the operation points at the bottom of the projected image are to be displayed or not displayed.
This performs the same operation as [Mask Marker] – [Orange] on the View submenu.
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⑦	 Editing Area
Click the operation points to select them, and then drag them to form the shape that is to be masked. 
The outmost red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left 
when the Image Direction setting is Landscape, and the location where it is shown also moves depending on the Image 
Direction setting.
The masking adjustment data that was loaded with Open File or loaded from the device is displayed in the projection 
screen, and if masking is already set, that part is displayed in black and the other parts are displayed in white. You 
can leave this masking setting as is and add or change new masking setting using Line Masking or Custom Masking 
described later. If you want to discard the loaded masking settings, execute [Reset Data (Current Tab)] on the File 
submenu. The inside of the projection image of the editing area turns light gray as a result.

⑧	 Mode Switching
OFF: Masking is not performed.
ON: Masking is enabled.

⑨	 Edit, View
In addition to the menu items described in “Main menu” (page 18), the following menu items can be used on the 
Masking screen.

Edit submenu
Reset

While Line Masking has been performed, the positions of the operation points are returned to their initial 
statuses.
While Custom Masking has been performed, all of the set masking areas are deleted.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.

View submenu
Masking Marker (Red, Green, Blue, Orange)

Selects whether the operation points of Line Masking are to be displayed or not displayed.
The non-displayed operation points are fixed at the positions when the selection was made not to display them.
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Line Masking

④③②⑤①

①	 Left
When a check mark is entered for  , masking based on the operation point on the left side of the projected image is 
enabled.

②	 Upper
When a check mark is entered for  , masking based on the operation point at the top of the projected image is 
enabled.

③	 Right
When a check mark is entered for  , masking based on the operation point on the right side of the projected image 
is enabled.

④	 Lower
When a check mark is entered for  , masking based on the operation point at the bottom of the projected image is 
enabled.

⑤	 Invert
When a check mark is entered for  , the Line Masking area can be inverted between positive and negative.

Note
If masking adjustment data that was loaded with Open File or loaded from the device is displayed, placing a check mark 
in Invert will invert between positive and negative only in the areas that Line Masking is performed, and will not invert 
between positive and negative in other areas. If you want to invert between positive and negative in areas in the entire 
projection image other than the areas that Line Masking is performed, execute [Reset Data (Current Tab)] on the File 
submenu and then configure the settings of Line Masking.

Left operation point (Red)

Upper operation point (Blue)

Lower operation point (Orange)

Right operation point (Green)

The operation points positioned at both ends of each side can be moved only around the outer circumference (along the 
four sides–top, bottom, left, and right) of the projected image.
When an operation point at the center of a side is moved, it can be moved without changing the angle of the straight line 
that connects the operation points at both ends of the side.  
When the operation points have been selected, they can also be moved by operating the cursor keys on the keyboard.

Right-clicking
Clicking the right-mouse button in the editing area displays a menu with following items. 

Reset, Flip Vertical, Flip Horizontal
The menu functions are the same as with the Edit submenu.
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Custom Masking

⑤ ⑥

① ② ③ ④

①	 Add Polygon
Click this to add a rectangular masking area to the center of the projected image.
You can click in the area with the mouse and then move, transform, or otherwise modify the masking area with the mouse 
or cursor keys.

Masking area operations
When you click [Add Polygon], a rectangular masking area is added to the center of the projected image. When you 
click to select the masking area, control points are displayed at the four corner vertices of the masking area.

You can drag the masking area, or press the cursor keys to move it up, down, left, or right.

If you click a control point, that control point turns light blue. You can change the shape of the masking area by dragging 
the light blue control point or pressing the cursor keys.

Note
Each press of a cursor key moves the control point by 1 pixel. Pressing the cursor key while holding down the Alt key 
moves it in increments of 4 pixels.
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Right-clicking
If you right-click on the outer circumference of the masking area, the following menu items are displayed.

Add Point
Add a control point to the right-clicked position. Up to 16 control points can be added to the outer circumference of 
each masking area.

Delete Point
Delete an added control point. However, when a rectangular masking area was added with [Add Polygon], the four 
points that were available from the beginning cannot be deleted.

Enable Bezier
If you right-click a control point and then select this item, the two straight lines to the adjacent control points 
become curved and the degree of that bulge and the position of the vertex can be set by operating the two light 
blue handles that are displayed.

Disable Bezier
Cancel the curving that was performed by Enable Bezier. The curved shape is returned to the original straight 
line.
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②	 Add Ellipse
Click this to add an elliptical masking area to the center of the projected image.
You can click in the area with the mouse and then move, transform, or otherwise modify the masking area with the mouse 
or cursor keys.
When you click to select inside an elliptical masking area, four control points are displayed.

You can change the shape of the ellipse by dragging a control point or pressing the cursor keys.

Note
Each press of a cursor key moves the control point by 1 pixel. Pressing the cursor key while holding down the Alt key 
moves it in increments of 4 pixels.

③	 Add Image 
Click this to display the screen to select bitmap data for masking on which you can select an image and place it in the 
editing area.
The loaded bitmap data can be moved, enlarged, or reduced with mouse operations in the same way as ② . The bitmap 
data can be moved, enlarged, or reduced in the same way as ② in a display area with a resolution of 2 880 x 1 620 pixels 
(when the resolution of the device is 1 920 x 1 080) or 5 760 x 3 240 pixels (when the resolution of the device is 3 840 x 
2 160).

④	 Delete Object
Click this to delete the currently selected masking area (one added in ① to ③ above).

⑤	 Invert
Place a check mark in this to change the currently selected masking area to an area where the projected image is 
transmitted without being masked.
Placing a check mark in Invert allows you to change the shape of a masking area by overlaying a transmitted area on 
another masking area. For example, you can create a masking area that is like a crescent moon with a rectangle on it by 
placing a large circular masking area and then placing a small circular area with a check mark in Invert on it, and then 
additionally placing a rectangular masking area on them.
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⑥	 Add Blending
Place a check in this to fully mask the center part of the currently selected masking area and apply processing to increase 
the transmittance toward the periphery. This processing cannot be applied to a masking area of bitmap data added by 
Add Image.

Initial state with check mark placed in Add Blending
The yellow gauge at the top left of the following figure 
has been moved to the very left, indicating that the entire 
area is a masking area.

State with yellow gauge moved toward the right
The area fully masked is reduced to the range of the yellow 
rectangle in the area.

Image of masking area applied to projected image

Right-clicking
Clicking by pressing the right button of the mouse in a location without an added masking area within the editing area 
displays a menu with the following items.

Reset, Flip Vertical, Flip Horizontal
The menu functions are the same as with the Edit submenu.



76

Auto Screen Adjustment
This allows automatic adjustment of geometry correction, edge blending, and black level to the shape of the screen through 
use of an externally connected camera.
After performing Auto Screen Adjustment, you can perform further detailed adjustment and correction manually.

Note
To use the Auto Screen Adjustment function, prepare a camera separately. 

Preparing Auto Screen Adjustment
 � Projector connection

Use a LAN cable to connect the projector to the computer.

 � Camera connection
Use a USB cable to connect the camera to the computer.
For details on compatible cameras, check the information found on the software download page after logging in to PASS on 
the following website.
https://docs.connect.panasonic.com/projector/pass

 � Connection example

Computer

Projectors

CameraHub

HDMI connection

Note
 z Positioning the camera so that it faces the screen directly and performing adjustments will obtain more optimal adjustment 
results. Adjustment is possible when the camera is facing the screen at an angle, but adjustment may fail or distortion may 
remain in images after adjustment if the angle is too large.

 z Only one camera can be used with the Auto Screen Adjustment function.
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Compatible screens for Auto Screen Adjustment
Auto Screen Adjustment may not be performed properly depending on the shape of the screen. If adjustment is not performed 
properly, perform adjustments manually.

Compatible screens Non-compatible screens
 z Flat

 z Curved screen

Curved in one direction Curved in two directions

 z Curve changes smoothly 

S-curve Variable curve type

 z Folded

Folded screen type

*   Individual adjustments for each side are 
possible.
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Operation flow for Auto Screen Adjustment
Settings for Auto Screen Adjustment are configured in a wizard format.

Camera Select (Camera selection)

Camera Setting

Camera search

Camera selection and connection

Camera settings

Adjustment items selection

Auto Screen Adjustment complete

Projection Setting
Geometry

Edge Blending Black Level

Projector Select (projector selection)
Projector selection
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Auto Screen Adjustment procedure

Starting Auto Screen Adjustment and selecting the adjustment item

1 Click the [AUTO ADJUST] button in the main screen.

2 Click the items you want to adjust.

Adjustment items selection screen

 z When performing Auto Screen Adjustment for a projector connected to a device (when FMP series is selected in the 
operation target selection drop-down list of the common operation area), you can select the following two items on the 
FMP series tab.
- [Geometry, Edge Blending]
- [Black Level]

When performing Auto Screen Adjustment for a projector connected not via a device but directly from this software, 
configure the settings while Projectors is selected in the operation target selection drop-down list of the common 
operation area. For details on the setting procedure in this case, refer to the operating instructions for “Geometry 
Manager Pro Ver.6.7.”

 z The subsequent steps and screens that appear in the procedure will vary depending on the selected items.
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Note
 z Make sure the device is turned on before starting Auto Screen Adjustment.
 z When performing Auto Screen Adjustment for the black level adjustment, do so in an environment where the impact from 
external lighting will be as low as possible.

 z If Auto Screen Adjustment for black level correction is executed for a combination of projectors of different models, 
matching of the black level with sufficient accuracy may not be possible.

 z While setting Auto Screen Adjustment, a progress indicator will appear at the top right of each screen, allowing you to 
check which step you are currently performing.

Progress indicator
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Camera Select (Camera selection)

1 Verify camera connection in the camera connection screen.

1) Click [Camera Search] button.
 z The Camera Search screen opens.
 z When the search results are displayed, select the camera to use for adjustment from those results.
 z If a camera is not displayed in the list, check the following.

   - The camera is properly connected.
   - The camera is turned on.

 z Verify that the check boxes of the cameras to be used are selected.
 z You can select all the cameras by clicking the [Select All] button, or clear selection of all the cameras by clicking 
the [Clear All] button.

2) Click [Next].
 z To return to the previous screen, click [Back].
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Projector Select

1 Select the projectors for which to perform correction in the projector selection screen.

The projectors connected to the device are displayed in the list. Select the projectors to which to apply Auto Screen 
Adjustment.

[Select All]

[Clear All]

Check boxes

Projector selection screen

1) Select the check boxes of the projectors for which you want to perform correction in the connected projectors list.
 z You can select all the projectors by clicking the [Select All] button, or clear selection of all the projectors by clicking 
the [Clear All] button.

2) Click [Next].
 z To return to the previous screen, click [Back].

Note
When you click [Next], the geometry correction and edge blending of the devices will be initialized.
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3) If the following screen is displayed, select the process for the black level of the area to be overlapped and then click 
[Next].

 z The following screen is displayed if you select [Geometry, Edge Blending] and then select two or more projectors in 
the projector selection screen.

  Select the process for the black level of the area to be overlapped.
 - [Use current settings]: Retain the current (pre-adjustment) black level value.
 - [Adjust using the camera]: Adjust the black level using the camera.

 When [Next] is clicked, the camera setting screen (page 84) is displayed.
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Camera Setting

1 Configure the camera you will use in the camera setting screen.

[View larger image]

[Live View]

Image display 
window

[Auto Setup]

[Manual Setup]

[White Balance / 
Shutter Speed / 
ISO / F-number]

[Test Shot]

             Camera setting screen

1) Click the [Auto Setup] button.
 z A test pattern appears on the screen, and camera configuration starts automatically.
 z The setting values configured in step 1) appear in the [White Balance / Shutter Speed / ISO / F-number] fields.  
You can select the [Manual Setup] check box to configure the setting values manually.

 z If [Black Level] is selected and [Adjust using the camera] was selected in Black Level Setting on page 83, next 
also set the camera for black level adjustment.

2) Capture a test shot.
 z A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display 
window. Verify that the entire screen fits within the image display window.

 z When you click the [View larger image] button, the content of the captured image display window is displayed 
enlarged in another window. If you resize that window, the captured image is also resized while maintaining the 
aspect ratio.

Note
 z To obtain the optimal adjustment results, make adjustments so that the target area of the screen fills as much of the 
captured image display window as possible.

 z Adjustment may fail if the target area of the screen does not fit properly within the captured image display window.
 z An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and 
configure settings again.

 z If the screen is too bright or there is a strong light present, overexposure may occur and adjustment may fail.

3) Click [Next].
 z To return to the previous screen, click [Back].
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Projection Setting
Adjust the option selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 79).
Perform the operations by referring to their explanations on the following pages.

 z Projector coordinate detection and detection range setting (common) 
 "Projector coordinate detection and detection range setting" (Page 85)

The adjustments are made for each of the selected items after projector coordinate detection finishes.
 z When [Geometry, Edge Blending] is selected 

 “Geometry and Edge Blending Adjustments” (page 89)
 z When “Black Level” is selected 

 “Black Level Adjustments” (page 96)

	� Projector coordinate detection and detection range setting

1 When the following confirmation screen appears, select the detection pattern and click [Next].

When you click [Next], detection of the projection coordinates using the selected detection pattern starts. Select the 
detection pattern that matches the screen characteristics or camera layout.
[Color]: Pattern recommended for a diffusion type white matte screen.
[Monochrome]:  Pattern recommended when using a screen with a narrow viewing angle such as a silver screen or when 

the camera cannot be placed in front of the screen.
 z Click [Back] to return to the previous screen.

Detection pattern setting screen
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2 When the projector coordinate detection results appear, check the detection results and click [Next].

 z Clicking [Back to Camera Setting] returns to the camera setting screen.

④ ① ②

③

⑥⑤⑦

①	 Detection result list
The following coordinate detection result details are displayed in the list. 
Camera ID / Camera name / Projector ID / Projector Name / Detection rate (displayed as %)

Note
The results of a projector with a low detection rate are displayed in yellow (possible to continue) or red (not possible 
to continue).
Detection may have failed because the part that should be projected was outside the screen or was not within the 
capture range of the camera. If necessary, reinstall the camera, click [Back to Camera Setting] to return to the 
previous screen, and perform projector coordinate detection again.

②	 Selected list detailed information
The following detailed information for the currently selected list is displayed.
Camera:  Shooting area / Camera name / Model information
Projector:  Projector name and IP address assigned by the device
Result:  Detection rate (displayed as percentage)

③	 Selected list coordinate detection point result display
The coordinate detection point result for the currently selected list is displayed.

④	 Coordinate detection retry check box
Select the lists for which to retry coordinate detection.

⑤	 Coordinate detection pattern selection
Select the detection pattern to perform coordinate detection again.
[Color]: Pattern recommended for a diffusion type white matte screen.
[Monochrome]:  Pattern recommended when using a screen with a narrow viewing angle such as a silver screen or 

when the camera cannot be placed in front of the screen.

⑥	 Coordinate detection point filtering detection
Specify the area you want to use as coordinate detection points.
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⑦	 Coordinate detection retry
Perform coordinate detection again for the lists with check marks.

Note
A coordinate detection point filtering specification screen such as the following is displayed by the operation of ⑥ . If 
walls other than the projection surface are included, such as when projecting onto a wall in an enclosed space, automatic 
adjustment may fail. In this screen, you can specify the area to perform coordination detection from the capture results of 
the camera or the areas to exclude from coordination detection.

①③② ⑤

④

⑥

⑦

Coordinate detection point filtering specification screen

①	 Selected list detailed information
The following detailed information for the currently selected list is displayed.
Camera:  Shooting area / Camera name / Model information
Projector: Projector name and IP address assigned by the device

②	 Filtering enable setting
Place a check mark in this check box when you want to enable filtering.

③	 Add Filter
This adds a filter.

④	 Filter setting screen
This area is for configuring filter settings on the image captured by the camera.

⑤	 Filter setting screen zoom setting
Zoom in the image displayed in the filter setting screen.

⑥	 OK button
When setting is finished, click this button to close the coordinate detection point filtering specification screen.
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⑦	 Invert (detection exclusion) specification
Place a check mark in this check box to specify an area to be excluded from coordinate detection.

Filter editing procedure
Yellow control points are displayed at the four corners of a filter added to the filter setting screen. If you click a 
control point, that control point turns red, and you can change the shape of the filter area by dragging with the 
mouse to move the position of the control point.

Right-clicking
If you right-click on a control point of a filter, the following menu items are displayed.

Add Point
This adds a control point. It is added at the point midway to the next control point clockwise.

Delete Point
Delete the selected control point.

Delete Filter
Delete the selected filter.
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	� Geometry and Edge Blending Adjustments

1 In the screen setting screen, adjust the image to be projected according to the shape of the screen.

[Coordinate]

Screen type

Number of cursors

[Cursor Reset]

[TestPattern] / [Marker] / 
[Edge Blending]

[Restore]Cursor

Screen setting 
window

Screen setting screen
(When [Projector] is selected in [Coordinate])

[Live View]

1) Set the screen setting method of the screen in [Coordinate].
 z In the screen setting screen, position the cursors in the screen setting window according to the shape of the 
screen. In [Coordinate], select one of the following for the display method of this cursor.
[Projector]: Move the cursors on the projector also in conjunction with the screen setting window.
[Camera]:  Set the cursors on the camera image displayed in the screen setting window.

2) Specify the screen type and number of cursors.
 z Select the screen type that matches the shape of the screen. Set the number of cursors according to the shape or 
curvature of the screen. 
[Flat]: Flat screen 
[Horizontal Curve]: Screen that is curved in the horizontal direction 
[Vertical Curve]: Screen that is curved in the vertical direction 
[H-V Curve]: Screen that is curved in the horizontal or vertical direction

 z The number of cursors that can be selected is a total of 300, with 2 to 100 per side when [Flat] is selected and 3 to 
100 per side when other than that is selected.

Note
When the software transitions to this screen, a number of cursors calculated from the number of projectors and layout 
information is set automatically. This value is merely supposed to serve as a guide. Change it to match the shape or 
curvature of the actual screen.

3) Position the cursors in the screen setting window according to the shape of the screen.
 z When [Projector] is selected in [Coordinate], position the cursors while checking the actual screen.
 z When [Camera] is selected in [Coordinate], position the cursors while checking the camera image displayed in the 
screen setting window.

Note
Take care not to create large differences in spacing between cursors in the placement on the actual screen. If there are 
parts with extremely different spacing, you may not be able to obtain the intended adjustment results.
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 z Position each cursor by dragging them or by using the arrow keys on the keyboard. When using the keyboard, 
pressing an arrow key while a cursor is selected moves the cursor 8 dots, pressing an arrow key while holding the 
Ctrl key moves the cursor 1 dot, and pressing an arrow key while holding the Alt key moves the cursor 64 dots.

 z You can select the next cursor by pressing the Tab key, or the previous cursor by pressing the Tab key while 
holding the Shift key.

 z You can also select cursors using the number keys on the keyboard.
 z If cursor layouts were previously configured, you can restore up to the three most recent cursor layout 
configurations using the [Restore] button. Select [the last], [the second last], or [the third last] from the pull-down 
menu to select the configuration you want to restore, and click the [Restore] button.

 z To return all cursors to their original positions, click [Cursor Reset].
 z The maximum number of cursors that are actually projected on the screen at one time is 100. Up to two digits can 
be be displayed for numbers on the screen, and the 100th, 200th, and 300th cursors will be displayed as “0.” For 
example, when you want to select the 101st cursor, press the Tab key while the 100th cursor is selected, or enter 
“101” using the keyboards number keys. The cursors that are projected are switched in groups of 100 in different 
colors. Cursors 1 to 100 are displayed in yellow, 101 to 200 in cyan, and 201 to 300 in magenta.

 z The cursor can be selected and moved while checking the live view images. Click [Live View] and configure the 
settings in live view. 

 “Live View” (page 99)
 z You can check the display using a test pattern by selecting a pattern from the [TestPattern] list. The following test 
patterns can be selected.
- [Black] / [White]: Black or white test pattern
-  [CrossHatch(White)] / [CrossHatch(Red)] / [CrossHatch(Green)] / [CrossHatch(Blue)] / [CrossHatch(Cyan)] / 

[CrossHatch(Magenta)] / [CrossHatch(Yellow)]: Mesh-design test pattern (displayed in the color included in the 
item name)

-  [FMP series Default] / [FMP series User Custom]: Default test pattern registered in the device or test pattern 
registered by the user

- [OFF]: No test pattern
 z When [Projector] is selected in [Coordinate], the necessary guide only can be displayed by changing the [Marker] 
setting. You can select any one of [OFF], [Cursor Only (Cursor)], and [ON (Cursor + Guide)].

 z You can switch between displaying with and without blending by placing or removing a check mark in/from [Edge 
Blending].

Note
When [ON (Cursor + Guide)] is selected in [Marker], a test pattern is not displayed even if other than [OFF] is selected in 
[TestPattern].
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 z When [Camera] is selected in [Coordinate], the screen setting window zoom and [Enlarged View] are enabled. 
Zooming in the camera image within the screen setting window or clicking [Enlarged View] to display the screen 
setting window enlarged within a separate window allows you to place the cursor in a more precise position.

[Enlarged View]

Screen setting window zoom

Screen setting screen
(When [Camera] is selected in [Coordinate])

2 If the content being projected has margins and you want to set the margin area, select the check box next to 
[Enable] by [Margin Setting] in the check screen setting screen.

 z Setting a screen margin makes it easier to set the position of cursors when making screen settings.
 z Setting of straight margins is possible. Setting of curved margins is not possible.

[Margin Setting]

Screen setting screen
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 z The margin setting screen opens.  
Select the type for margin with [Margin Type] and then set the margin size as a numeric value.

Margin type

Margin setting

[Restore]

[Reset]

[Open]

Margin setting screen

 z Select the margin type. 
[Horizontal]:  Horizontal margins at the top and bottom of the image 
[Vertical]: Vertical margins at the left and right sides of the image 
[Custom]: Margins other than the above

Note
[Auto Masking] for performing masking automatically cannot be selected.

 z Specify margins on each side individually. Select either [%] or [pixel] for [Scale] and enter the overall size of the projected 
content (including margins) in terms of the percentage or number of pixels. Note that the total margin that can be set on 
any given side cannot exceed 60%. 
If [pixel] is selected for [Scale], change the numerical value for [Total resolution] according to the overall content size.

 z Click the [Restore] button to restore the margins to the last previously set configuration.
 z Click the [Reset] button to return the configured margin size to the initial value (about 5%).
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 z Click the [Open] button to reads reference image files (files with the extension .bmp or .jpeg).

 z When done setting the margins, click [OK].  
Display returns to the screen setting screen.

3 Click [Start].

To save the projector positioning information, click [Start].
 z A progress bar appears, and Auto Screen Adjustment for geometry correction and edge blending starts.
 z To return to the previous screen, click [Back].

 z To cancel Auto Screen Adjustment, click [Abort].  
In such cases, click [OK] when the following screen appears.

Note
If Auto Screen Adjustment completes successfully, the adjustment results are reflected in the projected image and the 
screen setting screen is redisplayed. To configure the masking settings next, click [Masking] and then go to the procedure 
described in ““Masking” Adjustment” (page 95). To end setting, go to the next step.
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4 Click [Finish] on the screen setting screen.

When the following screen appears, click [Store] and then click [OK]. The data for the adjustment results up until now is 
saved in the device.

 z To not save the adjustment results to the computer, click [Not store] and then click [OK].
 z To change the settings and do the automatic adjustment again, change the settings on the screen setting screen or 
click [Back] to return to the previous screen, change the settings, and proceed with the settings up to the screen setting 
screen, and then click [Start] to do the automatic adjustment again.

If [Geometry, Edge Blending] was selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 
79) and [Use current settings] was selected in the black level adjustment screen (page 83), Auto Screen Adjustment 
is complete.

In the case of other than the above, go to the procedure of “■ Black Level Adjustments” (page 96)".

Note
 z When you click the  button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment 
appears. 
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

 z The cursor layout information configured during Auto Screen Adjustment is stored until the next time you configure the settings.
 z To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of 
“Geometry Manager Pro for FMP series”. 

 “Adjustment and Settings - Geometry Correction” (page 32)
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“Masking” Adjustment
The masking can be adjusted by placing various shaped masks on the camera image.

1 Click [Masking] on the screen setting screen.

[Masking]

Screen setting screen
The masking adjustment screen appears.

2 Add masks.

[Add Polygon]

[Add Ellipse]

[Delete]

[Finish]

Masking setting screen [Add Blending Rect]

[Update]

Perform one of the following operations depending on the shape of the masks to be added.
 z When adding a polygon mask, enter the number of vertices in the input field beside [Add Polygon] and then click [Add 
Polygon]. A polygon mask with the specified number of vertices is added to the masking setting screen.

 z When adding a rectangular mask with a gradient, click [Add Blending Rect]. A mask with a gradient applied around the 
rectangle is added to the masking setting screen.
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Auto Screen Adjustment Auto Screen Adjustment procedure

 z When adding a circular mask, click [Add Eclipse]. A circular mask is added to the masking setting screen.
Polygon mask Rectangular mask with gradient Circular mask

3 Adjust the masking by changing the positions and shapes of the masks on the masking setting screen.

 z A mask can be moved to any position on the masking setting screen by clicking to select the mask and then dragging it.

Note
An added/selected mask is displayed in red, and an unselected mask is displayed in yellow.

 z The shape and size of a mask can be changed by dragging the square control points displayed on or around the lines of 
the mask.

 z A rectangular mask with a gradient has a circular control point displayed on the mask. The gradient angle can be 
changed by dragging this control point.

 z If you click to select a mask and then click [Delete], the mask is deleted.

4 When adjustment of the masking is finished, click [Update] to reflect the masking in the projected image.

5 Click [Finish].

 � Black Level Adjustments
1 When the following confirmation screen appears, check the content displayed and click [Start].

When you click [Start], the projector settings will change to those displayed on this screen.
 z To return to the previous screen, click [Back].

Setting initialization confirmation screen
(black level adjustment)
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Auto Screen Adjustment Auto Screen Adjustment procedure

 z A progress bar appears, and Auto Screen Adjustment for black level adjustment starts.

 z To cancel Auto Screen Adjustment, click [Abort].  
Click [OK] when the following screen appears.

2 A message indicating that Auto Screen Adjustment is complete appears.

If [Geometry, Edge Blending] or [Black Level] was selected in “Starting Auto Screen Adjustment and selecting the 
adjustment item” (page 79), Auto Screen Adjustment is complete.
If you click [Apply] and then click [Finish], the adjustment values are reflected and Auto Screen Adjustment finishes.

 z If you want to finish adjustment without reflecting the adjustment values, select [Not Apply] and then click [Finish].

 z The following message appears if Auto Screen Adjustment could not be completed and must be performed again. If you 
click [Continue], Auto Screen Adjustment for the black level is performed again using the current adjustment values as 
the reference. To exit Auto Screen Adjustment for black level correction, click [Finish].
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Auto Screen Adjustment Auto Screen Adjustment procedure

 z You may not be able to obtain adequate adjustment results due to the impact of external lighting, such as when the 
surroundings are too bright or the brightness has changed In such cases, configure the camera settings again.

 z If adequate adjustment results cannot be obtained even after reconfiguring the camera settings, perform black level 
adjustment manually in the main screen of “Geometric & Setup Management Software (Geometry Manager Pro for FMP 
series).”  

 “Adjustment and Settings - Black Level Adjustment” (page 61)

Note
 z When you click the × button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment 
appears.  
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

 z To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of 
“Geometry Manager Pro for FMP series”.  

 “Adjustment and Settings - Black Level Adjustment” (page 61)
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Live View
Settings can be configured when, for example, it is difficult to go to the site or checking is difficult because the distance from 
the screen is far, by making installation adjustments while looking at live view images shot with a camera.

Note
The cameras that can be used with live view are the cameras compatible with Auto Screen Adjustment and some cameras that 
can connect to the LAN. For details on compatible cameras, check the information found on the software download page after 
logging in to PASS on the following website. 
https://docs.connect.panasonic.com/projector/pass

Live View Preparation
 � Camera connection

Use a USB cable or LAN cable to connect the camera to the computer.

Live View Procedure

Camera Search screen
Search for the camera to use in the live view.

①

②

③

④

⑤ ⑥

A USB connected camera

Select this when searching for a camera connected by USB.

B Network connected camera

Select this when connecting with a camera connected by LAN. The IP address needs to be specified.

C IP Address

Enter the IP address of the camera to connect. To search for the camera to connect, enter an IP address for which to start 
the search.

D End IP Address

To search for the camera to connect, select the check box and enter the IP address for which to end the search.
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Live View Live View Procedure

E Search / Connect

When a search for the camera to connect is performed, the search starts according to the entered information.
When a search for the camera to connect is not performed, an attempt is made to connect with the camera according to 
the entered information and the Live View screen appears if the connection is successful.
If the connection is successful, the Camera Search screen closes.

F Exit

Cancel the connection with the camera and close the Camera Search screen.

Camera List screen
When the camera search is completed, the Camera List screen appears.

①

② ③

④ ⑤

A List of cameras to connect

Displays a list of cameras that were detected by the search.

B Select All

Select all the detected cameras.

C Clear All

Clear the selection of all detected cameras.

D Back

Return to the Camera Search screen.

E OK

Connect with the selected cameras and display the Live View screen.
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Live View Live View Procedure

Live View screen
If the connections with the cameras are established correctly, the Live View screen appears.
If you resize the window, the Live View screen is also resized while maintaining the aspect ratio. However, it cannot be made 
smaller than the original window.

①

⑩

⑪

③

②

④

⑤

⑥

⑦

⑧

⑨

When cameras with LAN connections

A Camera list

Displays a list of the cameras connected with this application.

B Live View screen

This shows live view images of the selected camera.

C Preset

Move the camera to the pan, tilt, focus, and zoom settings of the selected preset position.

D Zoom

Set the camera zoom.

E Focus

Set the camera focus.

F Pan Tilt

Set the camera pan/tilt.

G Brightness

Set the camera brightness.

H WEB Setting

Open the Web browser to configure the camera settings.

Note
The preset settings of the camera need to be configured from the Web browser screen.

I Add

Add a camera.

J Single/Multi Selection

Switch live view display to a single camera only or multiple cameras.

K Exit

Close this screen and exit live view.
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Live View Live View Procedure

            

①

②

When cameras with USB connections

A Resolution

Set the resolution of live view images. The setting is fixed to [VGA].

Note
Even if you change the resolution, the display size of the Live View screen does not change.  
Display is enlarged or reduced to fit this range.

B Focus

Set the camera focus.

Mode:
Set the focus operation mode.

Area:
Set the AF area.

Manual:
Adjust the focus when [Mode] is [AF-S].

Note
 z When focus adjustment is performed, the operation may not be noticeable due to the corresponding amount of 
change being extremely small.

 z This is disabled when [Mode] is [Manual]. Adjust the focus by turning the focus ring of the lens when this mode is 
set.



103

Live View Live View Procedure

You can also check the live view images of multiple cameras at the same time.

Note
 z Live view continues even if Auto Screen Adjustment is started.  
However, live view images may temporarily disappear during various shooting with the Auto Screen Adjustment function.

 z The live view images of all of the cameras in the camera list are displayed in the live view of multiple cameras.  
However, when there are multiple cameras with USB connections connected, the following restrictions apply to the live view 
of multiple cameras.
- If a camera with a USB connection is selected immediately before switching to the live view of multiple cameras, the live 

view images of the cameras with USB connections that were not selected will be displayed all black.
- If a camera with a LAN connection is selected immediately before switching to the live view of multiple cameras, the live 

view images of the cameras with USB connections except the camera with a USB connection that has the smallest ID 
number will be displayed all black.

 z Display with live view of multiple cameras is slow compared with live view of a single camera. 
 z The live view images of multiple cameras cannot be resized even by resizing the window.
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Operation by Gamepad
Operation using a gamepad is supported for some functions of this application. This enables intuitive operation since you do 
not need to make adjustments while alternately looking at the projected images and computer screen.
Operation by gamepad is not possible for a projector connected via a device. Operation by gamepad is possible only when 
connected directly to a projector from this software. For details on the operating procedure in this case, refer to the operating 
instructions for “Geometry Manager Pro Ver.6.7.”
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Frequently Asked Questions
Check the following points once more before requesting repair. This information is for when connected via a device. When 
connected to a projector not via a device but directly, refer to the operating instructions for “Geometry Manager Pro Ver.6.7.”

Device is not recognized.

 z Has the device’s power been turned on?
 z Have the units been connected properly?  “Preparation” (page 10)
 z Has the device’s network been set up correctly?  “Setting the Device” (page 10)
 z Does the number of projectors connected via a device exceed 99?

No connection can be made between my device and my computer

 z When Windows Firewall has been detected

Enter “Windows Defender Firewall” in the search box of the taskbar and select [Windows Defender Firewall] in the results. 
Is this software registered in [Allow an app or feature through Windows Defender Firewall]?
If it is not, add this software in [Allow an app or feature through Windows Defender Firewall].

 z Adding procedure
1. Enter “Windows Defender Firewall” in the search box of the taskbar and then select [Windows Defender Firewall] in 

the displayed search results.
2. When the <Windows Defender Firewall> window appears, click [Allow an app or feature through Windows Defender 

Firewall].
3. When the <Allow apps to communicate through Windows Defender Firewall> window appears, click [Change settings] 

→ [Allow another app...].
4. When the <Add an app> dialog box appears, select [Geometry Manager Pro for FMP series] and click the [Add] 

button. 
If [Geometry Manager Pro for FMP series] is not in the list, click [Browse], select [GeometryGUI.exe], and click [Open]. 
[Geometry Manager Pro for FMP series] or [GeometryGUI] appears in the [Apps] column.

5. [Geometry Manager Pro for FMP series] or [GeometryGUI] appears in the [Allowed apps and features] column.
6. Select [Private] or [Public] for the network you want to allow connection to and click to select the check box.
7. Click [OK] in the <Allow apps to communicate through Windows Defender Firewall> window.
8. This software will now be added to the Windows Defender Firewall's exception application list.

<When another firewall has been detected>
Are any firewall-containing applications installed? 
If any applications which contain firewalls are installed, the installation may not complete. 
(The firewall function may activate without launch of the application if the application has already been installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.
See the User’s Manuals for all applications containing firewalls to perform these settings.

Messages that appear when an attempt to uninstall or update the software is made

<Is the "Warning 1910. Could not remove ..." message displayed?>
If an NVIDIA driver is installed on the computer, the following message may appear.

Click [OK] to continue an uninstall or update procedure.
Although uninstalling the software will also remove the desktop shortcut icons, they will be regenerated when you start 
up the computer next time. Manually delete the shortcut icons.
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Frequently Asked Questions

Files cannot be saved.

 z Has an attempt been made to save a file that includes values that exceed the range which can be set in the device?
 z Is there enough free memory on the hard disk?
 z Do you have the authority to access the folder in which the file is to be saved?

Files cannot be loaded.

 z Settings files (*.prj) saved when they were used by connecting with a projector without using a device cannot be loaded 
when connected to a device.

Image correction cannot be performed.

 z Have settings been sent to the device that exceed the range which can be set in the device?
 z Is the device turned on?

The bitmap used for masking purposes cannot be loaded.

 z Has an attempt been made to load bitmap data which is not in the 1-bit monochrome format?
 z Does the bitmap have the appropriate size? 
Bitmaps smaller than 8 x 8 pixels and bitmaps larger than 1 920 x 1 080 pixels (when the resolution of the projector is 
1 920 x 1 080 dots) or 3 840 x 2 160 pixels (when the resolution is other than the aforementioned) cannot be used for 
masking.

Cannot connect to the camera (Auto Screen Adjustment).

 z Is the camera turned on?
 z Is the camera connected to the computer properly?
 z Is there a large number of data files stored on the SD card inserted in the camera?  
If camera connection fails, try removing the SD card and performing the camera connection settings again.

 z If there is any SD card inserted in the computer or there is any device other than a camera connected via USB, remove 
them all and then reconfigure the settings.

The image does not fit exactly on flat screens (Auto Screen Adjustment).

 z The projected image may not match the edges of the screen exactly if the screen is sagging.  
If the top and bottom edges are off:  
In the screen setting screen, set the screen type to [Horizontal Curve], and specify at least 3 cursors according to the 
shape of the screen.  
If the left and right edges are off: 
In the screen setting screen, set the screen type to [Vertical Curve], and specify at least 3 cursors according to the 
shape of the screen.

Geometry correction results in an images that appears curved (Auto Screen Adjustment).

 z This occurs on soft curved screens and on screens with heavy sag. 
Correction is performed so that the image appears straight from the point of view of the camera. 
Position to the camera so that it is as close as possible to directly facing the screen.

An exposure adjustment error occurs on the camera (Auto Screen Adjustment).

 z If the projector is too bright or the screen's gain is high, for example, an exposure adjustment error may occur during 
camera settings configuration.  
In such cases, attach an ND filter to the camera lens, or lower the brightness of the projector before performing 
adjustment again.



Note
 z Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
 z Panasonic Projector & Display Corporation cannot be held liable for any effects resulting from the use of this software 
and manuals.

 z Panasonic Projector & Display Corporation reserves the right to revise this software specifications and manual contents 
without notice.
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Panasonic Projector & Display Corporation
Web Site : https://docs.connect.panasonic.com/projector
© Panasonic Projector & Display Corporation 2025

Trademarks
 z Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.

 z The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade dress and the HDMI Logos are trademarks or 
registered trademarks of HDMI Licensing Administrator, Inc.

 z Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the 
respective companies. Note that ® and TM marks are not indicated in the text of this manual.
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